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copyright laws.
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Regulatory Compliance
This product has been designed and
tested in accordance with accepted
industry standards, and has been
supplied in a safe condition. To review
the Declaration of Conformity, go to
http://www.keysight.com/go/conformity.

Warranty
THE MATERIAL CONTAINED IN THIS
DOCUMENT IS PROVIDED “AS IS,” AND
IS SUBJECT TO BEING CHANGED,
WITHOUT NOTICE, IN FUTURE
EDITIONS. FURTHER, TO THE
MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, KEYSIGHT
DISCLAIMS ALL WARRANTIES, EITHER
EXPRESS OR IMPLIED, WITH REGARD
TO THIS MANUAL AND ANY
INFORMATION CONTAINED HEREIN,
INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE. KEYSIGHT
SHALL NOT BE LIABLE FOR ERRORS
OR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES IN
CONNECTION WITH THE

FURNISHING, USE, OR
PERFORMANCE OF THIS DOCUMENT
OR OF ANY INFORMATION CONTAINED
HEREIN. SHOULD KEYSIGHT AND THE
USER HAVE A SEPARATE WRITTEN
AGREEMENT WITH WARRANTY TERMS
COVERING THE MATERIAL IN THIS
DOCUMENT THAT CONFLICT WITH
THESE TERMS, THE WARRANTY
TERMS IN THE SEPARATE
AGREEMENT SHALL CONTROL.

KEYSIGHT TECHNOLOGIES DOES NOT
WARRANT THIRD-PARTY SYSTEM-
LEVEL (COMBINATION OF CHASSIS,
CONTROLLERS, MODULES, ETC.)
PERFORMANCE, SAFETY, OR
REGULATORY COMPLIANCE, UNLESS
SPECIFICALLY STATED.

Technology Licenses
The hardware and/or software
described in this document are
furnished under a license and may be
used or copied only in accordance with
the terms of such license.

U.S. Government Rights
The Software is “commercial computer
software,” as defined by Federal
Acquisition Regulation (“FAR”) 2.101.
Pursuant to FAR 12.212 and 27.405-3
and Department of Defense FAR
Supplement (“DFARS”) 227.7202, the
U.S. government acquires commercial
computer software under the same
terms by which the software is
customarily provided to the public.
Accordingly, Keysight provides the
Software to U.S. government customers
under its standard commercial license,
which is embodied in its End User
License Agreement (EULA), a copy of
which can be found at
http://www.keysight.com/find/sweula. The
license set forth in the EULA represents
the exclusive authority by which the
U.S. government may use, modify,
distribute, or disclose the Software. The
EULA and the license set forth therein,
does not require or permit, among other
things, that Keysight: (1) Furnish
technical information related to
commercial computer software or
commercial computer software
documentation that is not customarily
provided to the public; or (2) Relinquish

to, or otherwise provide, the
government rights in excess of these
rights customarily provided to the
public to use, modify, reproduce,
release, perform, display, or disclose
commercial computer software or
commercial computer software
documentation. No additional
government requirements beyond
those set forth in the EULA shall apply,
except to the extent that those terms,
rights, or licenses are explicitly required
from all providers of commercial
computer software pursuant to the FAR
and the DFARS and are set forth
specifically in writing elsewhere in the
EULA. Keysight shall be under no
obligation to update, revise or otherwise
modify the Software. With respect to
any technical data as defined by FAR
2.101, pursuant to FAR 12.211 and
27.404.2 and DFARS 227.7102, the U.S.
government acquires no greater than
Limited Rights as defined in FAR 27.401
or DFAR 227.7103-5 (c), as applicable in
any technical data.

Safety Notices

A CAUTION notice denotes a hazard. It
calls attention to an operating
procedure, practice, or the like that, if
not correctly performed or adhered to,
could result in damage to the product
or loss of important data. Do not
proceed beyond a CAUTION notice until
the indicated conditions are fully
understood and met.

A WARNING notice denotes a hazard. It
calls attention to an operating
procedure, practice, or the like that, if
not correctly performed or adhered to,
could result in personal injury or death.
Do not proceed beyond a WARNING
notice until the indicated conditions are
fully understood and met.

The following safety precautions should
be observed before using this product
and any associated instrumentation.

This product is intended for use by
qualified personnel who recognize
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shock hazards and are familiar with the
safety precautions required to avoid
possible injury. Read and follow all
installation, operation, and
maintenance information carefully
before using the product.

If this product is not used as specified,
the protection provided by the
equipment could be impaired. This
product must be used in a normal
condition (in which all means for
protection are intact) only.

The types of product users are:

Responsible body is the individual or
group responsible for the use and main-
tenance of equipment, for ensuring that
the equipment is operated within its spe-
cifications and operating limits, and for
ensuring operators are adequately trained.

Operators use the product for its intended
function. They must be trained in electrical
safety procedures and proper use of the
instrument. They must be protected from
electric shock and contactwith hazardous
live circuits.

Maintenancepersonnel perform routine
procedures on the product to keep it oper-
ating properly (for example, setting the line
voltage or replacing consumablemater-
ials). Maintenanceprocedures are
described in the user documentation. The
procedures explicitly state if the operator
may perform them. Otherwise, they should
beperformed only by service personnel.

Service personnel are trained to work on
live circuits, perform safe installations, and
repair products. Only properly trained ser-
vice personnel may perform installation
and service procedures.

Operator is responsible to maintain safe
operating conditions. To ensure safe
operating conditions, modules should
not be operated beyond the full
temperature range specified in the
Environmental and physical
specification. Exceeding safe operating
conditions can result in shorter
lifespans, improper module

performance and user safety issues.
When the modules are in use and
operation within the specified full
temperature range is not maintained,
module surface temperatures may
exceed safe handling conditions which
can cause discomfort or burns if
touched. In the event of a module
exceeding the full temperature range,
always allow the module to cool before
touching or removing modules from
chassis.

Keysight products are designed for use
with electrical signals that are rated
Measurement Category I and
Measurement Category II, as described
in the International Electrotechnical
Commission (IEC) Standard IEC 60664.
Most measurement, control, and data
I/O signals are Measurement Category I
and must not be directly connected to
mains voltage or to voltage sources with
high transient over-voltages.
Measurement Category II connections
require protection for high transient
over-voltages often associated with
local AC mains connections. Assume all
measurement, control, and data I/O
connections are for connection to
Category I sources unless otherwise
marked or described in the user
documentation.

Exercise extreme caution when a shock
hazard is present. Lethal voltage may
be present on cable connector jacks or
test fixtures. The American National
Standards Institute (ANSI) states that a
shock hazard exists when voltage levels
greater than 30V RMS, 42.4V peak, or
60VDC are present. A good safety
practice is to expect that hazardous
voltage is present in any unknown
circuit before measuring.

Operators of this product must be
protected from electric shock at all
times. The responsible body must
ensure that operators are prevented
access and/or insulated from every
connection point. In some cases,
connections must be exposed to
potential human contact. Product
operators in these circumstances must
be trained to protect themselves from
the risk of electric shock. If the circuit is
capable of operating at or above 1000V,

no conductive part of the circuit may be
exposed.

Do not connect switching cards directly
to unlimited power circuits. They are
intended to be used with impedance-
limited sources. NEVER connect
switching cards directly to AC mains.
When connecting sources to switching
cards, install protective devices to limit
fault current and voltage to the card.

Before operating an instrument, ensure
that the line cord is connected to a
properly-grounded power receptacle.
Inspect the connecting cables, test
leads, and jumpers for possible wear,
cracks, or breaks before each use.

When installing equipment where
access to the main power cord is
restricted, such as rack mounting, a
separate main input power disconnect
device must be provided in close
proximity to the equipment and within
easy reach of the operator.

For maximum safety, do not touch the
product, test cables, or any other
instruments while power is applied to
the circuit under test. ALWAYS remove
power from the entire test system and
discharge any capacitors before:
connecting or disconnecting cables or
jumpers, installing or removing
switching cards, or making internal
changes, such as installing or removing
jumpers.

Do not touch any object that could
provide a current path to the common
side of the circuit under test or power
line (earth) ground. Always make
measurements with dry hands while
standing on a dry, insulated surface
capable of withstanding the voltage
being measured.

The instrument and accessories must
be used in accordance with its
specifications and operating
instructions, or the safety of the
equipment may be impaired.

Do not exceed the maximum signal
levels of the instruments and
accessories, as defined in the
specifications and operating
information, and as shown on the
instrument or test fixture panels, or
switching card.
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When fuses are used in a product,
replace with the same type and rating
for continued protection against fire
hazard.

Chassis connections must only be used
as shield connections for measuring
circuits, NOT as safety earth ground
connections.

If you are using a test fixture, keep the
lid closed while power is applied to the
device under test. Safe operation
requires the use of a lid interlock.

Instrumentation and accessories shall
not be connected to humans.

Before performing any maintenance,
disconnect the line cord and all test
cables.

To maintain protection from electric
shock and fire, replacement
components in mains circuits –
including the power transformer, test
leads, and input jacks – must be
purchased from Keysight. Standard
fuses with applicable national safety
approvals may be used if the rating and
type are the same. Other components
that are not safety-related may be
purchased from other suppliers as long
as they are equivalent to the original
component (note that selected parts
should be purchased only through
Keysight to maintain accuracy and
functionality of the product). If you are
unsure about the applicability of a
replacement component, call an
Keysight office for information.

No operator serviceable parts inside.
Refer servicing to qualified personnel.
To prevent electrical shock do not
remove covers. For continued
protection against fire hazard, replace
fuse with same type and rating.

PRODUCT MARKINGS:

The CE mark is a registered trademark
of the European Community.

Australian Communication and Media
Authority mark to indicate regulatory
compliance as a registered supplier.

This symbol indicates product
compliance with the Canadian
Interference-Causing Equipment
Standard (ICES-001). It also identifies
the product is an Industrial Scientific
and Medical Group 1 Class A product
(CISPR 11, Clause 4).

This product complies with the WEEE
Directive marketing requirement. The
affixed product label (above) indicates
that you must not discard this
electrical/electronic product in
domestic household waste. Product
Category: With reference to the
equipment types in the WEEE directive
Annex 1, this product is classified as
“Monitoring and Control
instrumentation” product. Do not
dispose in domestic household waste.
To return unwanted products, contact
your local Keysight office, or for more
information see
http://about.keysight.com/en/companyinfo/e
nvironment/takeback.shtml.

This symbol indicates the instrument is
sensitive to electrostatic discharge
(ESD). ESD can damage the highly
sensitive components in your
instrument. ESD damage is most likely
to occur as the module is being
installed or when cables are connected
or disconnected. Protect the circuits
from ESD damage by wearing a
grounding strap that provides a high
resistance path to ground. Alternatively,
ground yourself to discharge any built-
up static charge by touching the outer
shell of any grounded instrument
chassis before touching the port
connectors.

This symbol on an instrument means
caution, risk of danger. You should refer
to the operating instructions located in
the user documentation in all cases
where the symbol is marked on the
instrument.

This symbol indicates the time period
during which no hazardous or toxic
substance elements are expected to
leak or deteriorate during normal use.
Forty years is the expected useful life of
the product.
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1 Overview of the Quantum Engineering Toolkit (QET)
Keysight Technologies has developed the Quantum Engineering Toolkit (QET), a
powerful system for use in single andmulti-qubit research lab experiments. The goal
of QET is to provide an integrated solution, born from the strong electronics expertise
of Keysight Technologies, andmake it easily available to quantum laboratories all
around the world.

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

In this document...

This document describes the hardware and software installation process needed to
start up the Keysight Quantum Engineering Toolkit (QET) and get it ready for use.

Perform the following sequence:

1. Review Safety Requirements on page 3

2. Review Hardware Components on page 9

3. Install Hardware on page 17

4. Install Software on page 27

5. Verify Operation on page 33

6. Run the QET Initialization Utility on page 57
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2 Review Safety Requirements
Review all safety information in this section before operating any equipment.

Safety Notices on page 3

Before Applying LINE Power on page 3

General Safety on page 4

Servicing on page 5

Regulatory Information on page 6

Instrument Markings on page 7

2. 1 Safety Notices

The following safety notices are used throughout this document. Familiarize yourself
with each of the notices and their meaning before operating this system.

A CAUTION notice denotes a hazard. It calls attention to an
operating procedure, practice, or the like that, if not correctly
performed or adhered to, could result in damage to the product or
loss of important data. Do not proceed beyond a CAUTION notice
until the indicated conditions are fully understood andmet.

AWARNING notice denotes a hazard. It calls attention to an
operating procedure, practice, or the like that, if not correctly
performed or adhered to, could result in personal injury or death.
Do not proceed beyond a WARNING notice until the indicated
conditions are fully understood andmet.

2. 2 Before Applying LINE Power

Install the instrument so that the ON/OFF switch is readily
identifiable and is easily reached by the operator. The ON/OFF
switch or the detachable power cord is the instrument
disconnecting device. It disconnects the mains circuits from the
mains supply before other parts of the instrument. Alternately, an
externally installed switch or circuit breaker (which is readily
identifiable and is easily reached by the operator) may be used as
a disconnecting device.

Before switching on this instrument, make sure that the correct
fuse is installed and the supply voltage is in the specified range.



2 Review Safety Requirements

2. 3 General Safety

If this product is not used as specified, the protection provided by
the equipment could be impaired. This product must be used in a
normal condition (in which all means for protection are intact)
only.

This product is designed for use in Installation Category II and
Pollution Degree 2 per IEC 1010 and 664 respectively.

VENTILATIONREQUIREMENTS: When installing the product in a
cabinet, the convection into and out of the product must not be
restricted. The ambient temperature (outside the cabinet) must
be less than the maximumoperating temperature of the product
by 4°C for every 100Watts dissipated in the cabinet. If the total
power dissipated in the cabinet is greater that 800Watts, then
forced convectionmust be used

2. 4 Contacting Keysight

Assistance with test andmeasurements needs and information on finding a local
Keysight office are available on the Web at:
http://www.keysight.com/find/assist

4 Keysight QET Startup Guide
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2. 5 Servicing

No operator serviceable parts inside.
Refer servicing to qualified personnel.

To prevent electrical shock, do not remove covers.

Servicing instructions in this document are for use by qualified
personnel only. To avoid electrical shock, do not perform any
servicing unless you are qualified to do so.

The opening of covers or removal of parts is likely to expose
dangerous voltages. Disconnect the instrument from all voltage
sources while it is being opened

The power cord is connected to internal capacitors that may
remain live for 5 seconds after disconnecting the plug from its
power supply.

For continued protection against fire hazard replace line fuse only
with same type and rating (115 V and 230 V operation:
T2.5 A 250 V). The use of other fuses or material is prohibited.



2 Review Safety Requirements

2. 6 Regulatory Information

Keysight Technologies PXI modular instrument chassis and instrument cards comply
with the regulatory requirements listed in this section.

2. 6. 1 Compliance with Canadian EMC Requirements

This ISM device complies with Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB du Canada.

2. 6. 2 South Korean Class A EMC Declaration

2. 6. 3 Compliance with German Noise Requirements

This is to declare that this instrument is in conformance with the German Regulation
on Noise Declaration for Machines (Laermangabe nach der
Maschinenlaermrerordung –3. GSGV Deutschland).

Acoustic Noise Emission/Geraeuschemission

LpA <70 dB
Operator position
Normal position
per ISO 7779

LpA <70 dB
am Arbeitsplatz
normaler Betrieb
nach DIN 45635 t. 19

2. 6. 4 Declaration of Conformity

A Declaration of Conformity is on file for the PXI Series models and a copy is available
upon request.

6 Keysight QET Startup Guide
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2. 7 Instrument Markings

The instruction documentation symbol. The product is marked with this symbol when it
is necessary for the user to refer to the instructions in the documentation.

The AC symbol indicates the required nature of the line module input power.

This symbol indicates separate collection for electrical and electronic equipment, man-
dated under EU law as of August 13, 2005. All electric and electronic equipment are
required to be separated from normal waste for disposal (Reference WEEE Directive,
2002/96/EC).

This symbol indicates that the power line switch is ON.

This symbol indicates that the power line switch is in the STANDBY position.

This symbol indicates that the power line switch is in the OFF position.

This symbol is used to identify a terminal which is internally connected to the product
frame or chassis.

The CE mark is a registered trademark of the European Community. (If accompanied by
a year, it is when the design was proven.)

The CSA mark is a registered trademark of the CSA International.

This mark designates the product is an Industrial Scientific and Medical Group 1 Class
A product (reference CISPR 11, Clause 5).

This is a marking to indicate product compliance with the Canadian Interference-Caus-
ing Equipment Standard (ICES-001).

This mark designates Direct Current.

The instrument has been designed to meet the requirements of IP 2 0 for egress and
operational environment.

The RCM mark is a registered trademark of the Australian Communications and Media
Authority.
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Indicates the time period during which no hazardous or toxic substance elements are
expected to leak or deteriorate during normal use. Forty years is the expected useful life
of the product.

This symbol on all primary or secondary packaging indicates compliance to China stand-
ard GB 18455-2001.

South Korean Certification (KC) mark; includes the marking's identifier code which fol-
lows the format: MSIP-REM-YYY-ZZZZZZZZZZZZZZ or KCC-REM-YYY-ZZZZZZZZZZZZ.

8 Keysight QET Startup Guide
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3 Review Hardware Components
Before installing hardware or software, review the following hardware components.

The following list of hardware components are the recommended
models usedwith the Keysight QuantumEngineering Toolkit.
Many of these hardware components have optional or alternate
models available.

Review the following hardware components:

Hardware Components on page 10
HP Z8 G4Workstation

M9049A PCIe Interface Module

M9023A Slot-1 PXIe Interface Module

Y1202A or Y1203A PCIe Cable

M9019A PXIe Chassis

M3202A PXIe Arbitrary WaveformGenerator

M3102A PXIe Digitizer

M9347AH01 PXIe Dual DDS (LO)

(Optional) M9037A Slot-1 PXIe Embedded Controller

(Optional) M9300A PXIe Frequency Reference

Y1212A Slot Blockers and Y1213A EMC Filler Panels

U3022AH37 I/QModulator/Demodulator

Frequency-Band: 3 to 7 GHz, 5 to 9 GHz, or 6 to 18 GHz

High-Pass Filter

8493A-30 Coaxial Fixed Attenuator

E8267D PSG Vector Signal Generator (Frequency Reference)

(Optional) Splitter/Power Divider

(Optional) E3662B Rack Cabinet

Cables, SMA (m) to SMA (m) on page 15

(Optional) Test Equipment on page 15
N9040B UXA Signal Analyzer (or equivalent)

DSA90254A Oscilloscope (or equivalent)



3 Review Hardware Components

3. 1 Hardware Components

Select either an HP Z8 G4Workstation or M9037A Slot-1 PXIe Embedded Controller.

A Keysight M9037A Slot-1 PXIe embedded controller is only
needed if an HP Z8 G4Workstation or equivalent is not used.

HP Z8 G4Workstation

The HP Z8 G4Workstation contains a customized
BIOS that allows additional PCIe addresses to be
located whenmultiple PXIe chassis are connected to
the PCIe bus.

If one to three chassis are needed in an equipment
configuration, use the HP Z8 G4Workstation in place
of a Slot-1 PXIe embedded controller.

If four to six chassis are needed in an equipment
configuration, use this HP Z8 G4Workstation, with an
added dual-processor, in place of a Slot-1 PXIe
embedded controller.

Alternate:

See Tested PC and PXI/AXIe Chassis Configurations (5990-7632EN).

PCIe Interface Module
Keysight M9049A PCIe High Performance Host Adapter: Dual Port (x16), Gen 3

One M9049A PCIe Host Adapter is installed in one of the PCIe expansion slots in
the back of the HP Z8 G4Workstation.

One PCIe output port is connected, using Keysight Y1202A or Y1203A PCIe
cable, to one of the input connectors on the front of the M9023A PXIe System
Module - located in Slot-1 of the M9019A PXIe Chassis.

Alternate:

Keysight M9048B PCIe Host Adapter: Single Port, x8, Gen 3

10 Keysight QET Startup Guide
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Slot-1 PXIe Interface Module
Keysight M9023A PXIe High Performance System Module: Dual Port (x16), Gen 3

One PCIe output port is connected, using Keysight Y1202A or Y1203A PCIe
Cable, to one of the input connectors on the front of the M9023A PXIe System
Module - located in Slot-1 of the M9019A PXIe Chassis.

One M9049A PCIe Host Adapter is installed in one of the PCIe expansion slots in
the back of the HP Z8 G4Workstation.

Alternate:

Keysight M9022A PXIe System Module: Single Port, x8, Gen 3

PCIe Cable
Keysight Y1202A or Y1203A PCIe Cable

Keysight Y1202A PCIe Cable: x8, 2.0 m

Keysight Y1203A PCIe Cable: x8, 0.5 m

(Optional) Slot-1 PXIe Embedded Controller
Keysight M9037A PXIe High Performance Embedded Controller: 4-slot, 3U, Gen 3

This Slot-1 PXIe embedded controller is only needed if
an HP Z8 G4Workstation or equivalent is not used.

Alternate:

Keysight M9036A PXIe Embedded Controller: 3-slot, 3U, Gen 2

See HP Z8 G4Workstation on page 10.

See Tested PC and PXI/AXIe Chassis Configurations (5990-7632EN).

PXIe Chassis
Keysight M9019A PXIe Chassis: 18-slot, 3U, 24 GB/s, Gen 3

Alternate:

Keysight M9018B PXIe Chassis: 18-slot, 3U, 8 GB/s, Gen 2

Keysight M9010A PXIe Chassis: 10-slot, 3U, 24 GB/s, Gen 3

https://literature.cdn.keysight.com/litweb/pdf/5990-7632EN.pdf
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AWG
Keysight M3202A PXIe Arbitrary Waveform Generator: 1 GSa/s, 14 bit, 400 MHz

Optional:

M3202A-HV1 Enabled HVI programming, if used with
Keysight M3601A Hard Virtual Instrument (HVI) Design Environment Software

M3202A-FP1 Enabled FPGA programming
if used with Keysight M3602A FPGA Design Environment Software

requires Option K32 or K41 and Memory Option M20

Alternate:

Keysight M3201A PXIe Arbitrary Waveform Generator:
500 MSa/s, 16 bit, 200 MHz

Keysight M3300A PXIe AWG and Digitizer Combination:
500 MSa/s, 16 bit and 100 MSa/s, 14 bit

Keysight M3302A PXIe AWG and Digitizer Combination:
500 MSa/s, 16 bit, and 500 MSa/s, 14 bit

Digitizer
Keysight M3102A PXIe Digitizer: 500 MSa/s, 14 bit, 200 MHz

Optional:

M3102A-HV1 Enabled HVI programming, if used with
Keysight M3601A Hard Virtual Instrument (HVI) Design Environment Software

M3102A-FP1 Enabled FPGA programming
if used with Keysight M3602A FPGA Design Environment Software

requires Option K32 or K41 and Memory Option M20

Alternate:

Keysight M3100A PXIe Digitizer: 100 MSa/s, 14 bit, 100 MHz

Keysight M3300A PXIe AWG and Digitizer Combination:
500 MSa/s, 16 bit and 100 MSa/s, 14 bit

Keysight M3302A PXIe AWG and Digitizer Combination:
500 MSa/s, 16 bit, and 500 MSa/s, 14 bit

Dual DDS (LO)
Keysight M9347AH01 PXIe Dual Direct Digital Synthesizer Module: 9 kHz to 12 GHz

To help with cooling, it is recommended that the
M9347AH01 have empty slots on both sides of the
module; the empty slots should contain both slot
blockers and EMC filler panels.

There are two clock input ports on the M9347AH01, "Clock In" and "Ref In":

Clock In is designed for inputs of 4.8 GHz and 19.2 GHz at 0 to +20 dBm.
The optimal input frequency and power used to drive the Clock In port is
19.2 GHz @ 0 dBm. See Keysight E8267D PSG Vector Signal
Generator on page 14.

12 Keysight QET Startup Guide
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Ref In is designed for inputs of 100 MHz at 0 to +14 dBm.
See Keysight M9300A PXIe Frequency Reference.

Both Clock In and Ref In cannot be used at the same time.

The Clock Source selection, on the Keysight M9347 PXIe Module SFP, from the
DDS Control tab, must match the selected port being used.

(Optional) PXIe Frequency Reference

Keysight M9300A PXIe Frequency Reference: 100 MHz

When using the Keysight M9018B or M9019A PXIe
Chassis, the M9300Amust be installed in Slot-10 for
proper time synchronization between instruments.
When using the Keysight M9010A PXIe Chassis, the
M9300Amust be installed in Slot-6 for proper time
synchronization between instruments

The M9300A can be used to drive the M9347AH01 Ref In with 100 MHz at 0 to +14 dBm.
The output of the M9300A can be fed into a splitter; the outputs can feed up to eight
M9347AH01.

Slot Blockers
Keysight Y1212A Qty 1 Slot blocker kit: 5 slots

The Y1212A is used to block unused slots in the PXIe chassis. These slot blockers can be
placed in empty slots to help improve airflow through PXIe modules.

EMC Filler Panels
Keysight Y1213A Qty 1 PXI EMC filler panel kit: 5 slots

The Y1213A is used to block EMC from unused slots in the PXIe chassis.

I/Q Modulator/Demodulator

Keysight U3022AH37 I/Q Modulator/Demodulator Test Set

Can be configured as all I/Q Modulators, all I/Q Demodulators,
or a combination of I/Q Modulators and/or I/Q Demodulators.

I/Q Modulators and I/Q Demodulators are available in
three frequency-band options: 3 to 7 GHz, 5 to 9 GHz, or 6 to 18 GHz.

All I and Q port bandwidths are 10 MHz to 500 MHz.

Provides up-conversion (through the I/Q Modulator path) and
down-conversion (through the I/Q Demodulator path).

I/Q Modulator sections have a SPST solid-state switch (Pin Sw connector) for
providing isolation.

I/Q Modulator Pin Sw connector is an SMB (m). If
using an SMA (m) to SMA (m) cable to connect to
I/Q Modulator Pin Sw, use an SMA (f) to SMB (m)
to SMB (f) to SMB (f) or an SMA (f) to SMB (f).
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SMA (f) to SMB (m) Adapter (p/n 1250-0674)
SMB (f) to SMB (f) Adapter (p/n 1250-4000)

The I/Q Modulator Pin Sw connector is an SMB (m). Use an SMA (f) to SMB (m) adapter
connected to an SMB (f) to SMB (f) adapter or use an SMA (f) to SMB (f).

High-Pass Filter
Mini-Circuits 15542 High-Pass Filter: 2,010 MHz to 10,100 MHz

Alternate:

The selection of a high-pass filter is dependent on the frequency range of the
I/Q Modulator/ Demodulator being used; I/Q Modulator/Demodulator test sets
are available for frequency ranges:

3 to 7 GHz

5 to 9 GHz

6 to 18 GHz

Coaxial Fixed Attenuator
Keysight 8493A-30 Coaxial Fixed Attenuator: DC to 12.4 GHz, 30 dB

Alternate:

Keysight 8493B-30 Coaxial Fixed Attenuator: DC to 18 GHz, 30 dB

Frequency Reference

Keysight E8267D PSG Vector Signal Generator

E8267D-520 Frequency Range, 250 kHz to 20 GHz (Used as a 19.2 GHz clock.)

E8267D-UNY Ultra-Low Phase Noise Performance

E8267D-520 instruments ship with a 3.5 mm (m) RF output connector on the front panel.

E8267D-532 and -544 instruments ship with a 2.4 mm (m) RF output connector on the
front panel.

The RF Output of the E8267D can be fed into an optional splitter; the outputs of the
splitter can be fed into the inputs of up to eight M9347AH01.

The Clock In port on the Keysight M9347AH01 PXIe Dual Direct Digital Synthesizer is
designed for inputs of 4.8 GHz and 19.2 GHz at 0 to +20 dBm.
The optimal input frequency and power used to drive the Clock In port is
19.2 GHz @ 0 dBm.

Optional:

Keysight E8257D PSG Analog Signal Generator with Options 520 and UNY

See Keysight M9300A PXIe Frequency Reference: 100 MHz on page 13

14 Keysight QET Startup Guide
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(Optional) Splitter/Power Divider
8-Way Power Divider, PULSAR MICROWAVE CORPORATION, PS8-53-454/4S,
(https://www.pulsarmicrowave.com/spec_sheets/PS8-53-454-4S.pdf) or equivalent.

This power divider was selected for minimum loss.

(Optional) Rack Cabinet
Keysight E3662B Rack Cabinet, 2.0 m

Alternate:

Keysight E3661B Rack Cabinet, 1.6 m

3. 2 Cables, SMA (m) to SMA (m)

Cables, SMA (m) to SMA (m)
In all equipment setups throughout this document, cables are shown in different colors
for clarity only. All cables are RF Cable Assemblies, SMA (m) to SMA (m).
Keysight recommends Huber+Suhner, SUCOFLEX 126 (http://www.hubersuhner.com) or
equivalent.

3. 3 (Optional) Test Equipment

The following test equipment may be used when verifying operation.

Signal Analyzer

Keysight N9040B UXA Signal Analyzer

N9040B-508 Frequency Range, 2 Hz to 8.4 GHz

or N9040B-513 Frequency Range, 2 Hz to 13.6 GHz

or N9040B-526 Frequency Range, 2 Hz to 26.5 GHz

The frequency range option that is selected depends on the frequency range of
the Keysight U3022AH37 I/Q Modulator/Demodulator Test Set on page 13
being used.

Use this equipment or equivalent to measure signals when verifying operation.
See Verify Operation on page 33.

Alternate:

Keysight N9030B PXA Signal Analyzer

Oscilloscope
Keysight DSA90254A Infiniium High Performance Oscilloscope: 2.5 GHz

Use this equipment or equivalent to measure signals when verifying operation.
See Verify Operation on page 33.

https://www.pulsarmicrowave.com/spec_sheets/PS8-53-454-4S.pdf
https://www.hubersuhner.com/en/solutions/space/products/microwave-cable-assemblies/sucoflex-100
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4 Install Hardware

Before installing hardware, Review Safety
Requirements on page 3.

The following list of hardware components are the recommended
models usedwith the Keysight QuantumEngineering Toolkit. The
hardware configurations are shown using the Keysight M9019A
PXIe Chassis; this chassis andmany other hardware components
may have optional or alternate models available. Refer to Review
Hardware Components on page 9.

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

Perform the following sequence when installing hardware:

1. Install an HP Z8 G4Workstation on page 18

2. Install Hardware on a Workbench on page 19

a. Install a PXIe Chassis on page 20

b. Install PXIe Modules on page 20

c. Install Slot Blockers and EMC Filler Panels on page 21

d. Install an I/QModulator/Demodulator Test Set on page 21

e. Install a Frequency Reference on page 21

f. Connect Cables, High-Pass Filter, and Attenuator on page 23

3. (Optional) Install Hardware in a Rack Cabinet on page 24
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4. 1 Install an HP Z8 G4Workstation

This HP Z8 G4Workstation contains a customized
BIOS that allows additional PCIe addresses to be
located whenmultiple PXIe chassis are connected to
the PCIe bus.

If one to three chassis are needed in the equipment
configuration, use this HP Z8 G4Workstation in place
of a Slot-1 PXIe embedded controller.

If four to six chassis are needed in the equipment
configuration, use this HP Z8 G4Workstation, with
the added dual-processor, in place of a Slot-1 PXIe
embedded controller.

Interface Module
Keysight M9049A PCIe High Performance Host Adapter: Dual Port (x16), Gen 3

One M9049A PCIe Host Adapter is installed in one of the PCIe expansion slots
in the back of the HP Z8 G4Workstation.

One PCIe output port is connected, using Keysight Y1202A or Y1203A PCIe
Cable, to one of the input connectors on the front of the M9023A PXIe System
Module - located in Slot-1 of the M9019A PXIe Chassis.

Slot-1 PXIe Interface Module
Keysight M9023A PXIe High Performance System Module: Dual Port (x16), Gen 3

One PCIe output port is connected, using Keysight Y1202A or Y1203A PCIe
Cable, to one of the input connectors on the front of the M9023A PXIe System
Module - located in Slot-1 of the M9019A PXIe Chassis.

One M9049A PCIe Host Adapter is installed in one of the PCIe expansion slots
in the back of the HP Z8 G4Workstation.

For detailed instructions, refer to the Keysight PXIe System Modules and Cable
Interface, Installation Guide (M9022-90001).

PCIe Cable
Keysight Y1202A or Y1203A PCIe Cable

Keysight Y1202A PCIe Cable: x8, 2.0 m

Keysight Y1203A PCIe Cable: x8, 0.5 m

18 Keysight QET Startup Guide
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4. 2 Install Hardware on a Workbench

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

Perform the following sequence when installing hardware on a workbench:

1. Install a PXIe Chassis on page 20

2. Install PXIe Modules on page 20

3. Install Slot Blockers and EMC Filler Panels on page 21

4. Install an I/QModulator/Demodulator Test Set on page 21

5. Install a Frequency Reference on page 21

6. Connect Cables, High-Pass Filter, and Attenuator on page 23
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4. 2. 1 Install a PXIe Chassis

Keysight M9019A PXIe Chassis: 18-slot, 3U, 24 GB/s, Gen 3

1. Verify the chassis power switch is Off.

2. Verify the line cord is plugged into a grounded outlet to establish earth ground.

3. If the chassis has multiple fan speed settings, verify the fan switch is set to
HIGH and the inhibit switch is set to DEF.

For detailed instructions, refer to the Keysight PXIe Chassis Family,
Startup Guide for the M9019A, M9018B, and M9010A (M9019-90001).

4. 2. 2 Install PXIe Modules

1. Holding each module by the injector/ejector handle, slide it into an available slot.

2. Install each module into a slot in the chassis by placing the module card edges into
the front module guides (top and bottom). Note that a generic module installation is
shown and may not reflect your module's actual size or placement.

3. Slide each module to the rear of the chassis and ensure that the injector/ejector
handle is pushed down in the unlatched (downward) position.

4. Slide each module completely into the chassis. When you begin to feel resistance,
pull up on the injector/ejector handle to fully inject the module into the chassis.

5. Secure all modules to the chassis using the module mounting screws.

Use a #1 Pozidriv or slotted screwdriver and torque
all module mounting screws to 5 in-lb (0.57 N m).

Performance may suffer if the screws are not tightened properly.

Do not remove or insert any PXIe cards
into the chassis with the power on. This
could cause irreparable damage to
both the PXIe cards and the chassis.

To help with cooling, it is
recommended that each Keysight
M9347AH01 PXIe Dual DDS module be
located in a slot of the PXIe chassis that
has empty slots on both sides of the
module; these empty slots should
contain both slot blockers and EMC
filler panels. (See M9347-90001.)
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4 Install Hardware

Keysight QET Startup Guide 21

4. 2. 3 Install Slot Blockers and EMC Filler Panels

Missing slot blockers or EMC filler panels may disrupt air
circulation in the chassis and are required to meet data sheet
specifications. The left-most slot in the PXIe chassis does not
accept a slot blocker.

If there are any empty slots in the PXIe chassis after installing all PXIe modules:

1. Install slot blockers.

2. Install EMC filler panels.

Keysight Y1212A Qty 1 Slot blocker kit: 5 slots

Keysight Y1213A Qty 1 PXI EMC filler panel kit: 5 slots

4. 2. 4 Install an I/Q Modulator/Demodulator Test Set

Keysight U3022AH37 I/Q Modulator/Demodulator Test Set

For detailed instructions, refer to the Keysight U3022AH37 I/Q Modulator/Demodulator
Test Set, User's and Service Guide (U3022-90011).

4. 2. 5 Install a Frequency Reference

Keysight E8267D PSG Vector Signal Generator

E8267D-UNY Ultra-Low Phase Noise Performance

E8267D-520 Frequency Range, 250 kHz to 20 GHz (Used as 19.2 GHz clock.)

RF output connector on the front panel:
Option-520 ships with a 3.5 mm (m)

Option-532 and -544 ships with a 2.4 mm (m)

The RF output of the E8267D can be fed into an optional splitter; the outputs of the
splitter can be fed into the inputs of up to eight M9347AH01.

The Clock In port on the Keysight M9347AH01 PXIe Dual Direct Digital Synthesizer is
designed for inputs of 4.8 GHz and 19.2 GHz at 0 to +20 dBm. The optimal input
frequency and power used to drive the Clock In port is 19.2 GHz @ 0 dBm.
For detailed instructions, refer to the Keysight E8257D/67D PSG Signal Generators,
Installation Guide (E8251-90352).

https://literature.cdn.keysight.com/litweb/pdf/E8251-90352.pdf
https://literature.cdn.keysight.com/litweb/pdf/E8251-90352.pdf
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(Optional) Power Divider
8-Way Power Divider, PULSAR MICROWAVE CORPORATION, PS8-53-454/4S,
(https://www.pulsarmicrowave.com/spec_sheets/PS8-53-454-4S.pdf) or equivalent.

22 Keysight QET Startup Guide

https://www.pulsarmicrowave.com/spec_sheets/PS8-53-454-4S.pdf


4 Install Hardware

Keysight QET Startup Guide 23

4. 2. 6 Connect Cables, High-Pass Filter, and Attenuator

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

1. Connect a Y1202A or Y1203A PCIe cable to an M9049A or M9049B PCIe Host
Adapter in the HP Z8 G4Workstation.

2. Connect SMA (m) to SMA (m) cables from an AWG to an I/QModulator:

a. Connect AWGCh 1 Out to I/QModulator I In.

b. Connect AWGCh 2 Out to I/QModulator Q In.

c. Connect AWGCh 3 Out to I/QModulator Pin Sw.

d. I/QModulator Pin Sw connector is an SMB (m). If using
an SMA (m) to SMA (m) cable to connect to
I/QModulator Pin Sw, use an SMA (f) to SMB (m) to
SMB (f) to SMB (f) or a single SMA (f) to SMB (f).

3. Connect SMA (m) to SMA (m) cables from an I/Q Demodulator to a Digitizer:

a. Connect the I/Q Demodulator I Out to Digitizer Ch 1 In.

b. Connect the I/Q Demodulator Q Out to Digitizer Ch 2 In.

4. Connect the E8267D PSG RF Output to the M9347AH01 Clock In:

a. Connect a 3.5 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 520
or connect a 2.4 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 532 or 544.

b. Connect one end of SMA (m) to SMA (m) cable to the 3.5 mm (f) adapter.

c. Connect the other end of the SMA cable to the M9347AH01 Clock In.

5. Connect SMA (m) to SMA (m) cables fromM9347AH01 to both the I/QMod-
ulator and I/Q Demodulator:

a. Connect the M9347AH01 Synth Out 1 to I/QModulator LO In.

b. Connect the M9347AH01 Synth Out 2 to I/Q Demodulator LO In.

6. Connect a high-pass filter directly to the I/QModulator RF Out.
(This high-pass filter helps protect other devices from high power out.)

7. Connect a 30 dB attenuator directly to the I/Q Demodulator RF In.
(The maximumU3022AH37 I/Q Demodulator RF In Power is 0 dBm.
This 30 dB attenuator may be removed when running actual Qubit
measurements; it is used here to protect the I/Q Demodulator RF In.)
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4. 3 (Optional) Install Hardware in a Rack Cabinet

Hardware Placement in a Rack Cabinet

Order of Hardware Installation
Always begin installing the PXIe
chassis and heavy instruments at
the bottom of the rack andwork
up. This maintains a lower center
of gravity and reduces the
possibility of the rack tipping.

Maximum Load
Racks can be loadedwith a total of
1800 pounds (~816 Kilograms).

Anti-tip Stabilizer
Standard on each Keysight rack is
a retractable anti-tip stabilizer
mechanism. Located at the
bottom center of the rack, it
provides temporary additional
stability when installing or
removing equipment components.
The anti-tip stabilizer should also
be usedwhen slide-mounted
components are in their extended
position.

Rackmounting kits:

Keysight M9019A andM9018B PXIe Chassis,
use Keysight Y1215C Flush Mount Adapter and Y1217A Rack Rail Kit.

Keysight M9010A PXIe Chassis,
use Keysight Y1271A Rackmount Kit and Y1217A Rack Rail Kit.

Keysight U3022AH37 I/QModulator/Demodulator Test Set,
use Keysight 1CP108A, Rack Mount Flange and Handle Kit,
132.6 mmH (3U) - Two Brackets and Front Handles.

Keysight E8267D PSG Vector Signal Generator,
use 1CP106A RackMount Flange and Handle Kit,
177.0 mmH (4U) - Brackets, Handles, Hole Plugs.
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4. 3. 1 Install a Rack Cabinet

Rack Cabinet
Keysight E3662B Rack Cabinet, 2.0 m, 41U

For detailed instructions on racking equipment, refer to the Keysight Instrument Rack,
User Manual for the E7590A, E3661B, and E3662B (5967-9318).

4. 3. 1. 1 Install rack cabinet support rails

1. Decide where in the rack the equipment is to be installed.

Always begin installing the PXIe
chassis and heavy instruments at
the bottom of the rack and work
up. This maintains a lower center
of gravity and reduces the
possibility of the rack tipping.

2. Locate the rectangular mounting holes for the support rail.

Every fifth mounting hole is
notched.

3. Position the four Tinnerman (10-32) nuts over the round holes
adjacent to the rectangular mounting slots.

4. Slip the rail flanges into the rectangular mounting holes.

The rail should stay in place.

Although rails will sit on
columns, always secure rails
with TORX screws prior to
installing equipment.

5. Verify that the Tinnerman nuts are aligned with the mounting
holes in the rail.

6. Insert and tighten the mounting screws (10-32) on both the
front and rear vertical columns. Repeat for the other rail.

7. Install the piece of equipment.

8. Slide it all the way into the rack, bezel flush with the front of
the columns.

9. Secure to the rack columns if necessary.

https://literature.cdn.keysight.com/litweb/pdf/5967-9318.pdf
https://literature.cdn.keysight.com/litweb/pdf/5967-9318.pdf
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5 Install Software
The Keysight Quantum Engineering Toolkit SetupWizard installs all software needed
to operate the Quantum Engineering Toolkit (QET).

Software is installed in the following order:

Microsoft .NET Framework

Keysight IO Libraries Suite

Keysight M902x PXIe SystemModule

Keysight PXIe Chassis Family

Keysight M9347 PXI LO Drivers

Keysight SD1 Drivers, Libraries, and SFP

Keysight M3601A HVI Programming Environment

Keysight M3602A FPGA Programming Environment

Keysight QET Initialization Utility

Refer to the Quantum_Engineering_Toolkit_Readme.txt file for details on the specific
versions of software that are being installed. Unless it is changed during the
installation process, this file can be found in the following default location:
C:\Users\<CurrentUser>\Documents\Keysight Quantum Engineering Toolkit

If any software is already installed, a prompt will ask if you would
like to "Modify", "Repair", or "Remove" the software;
"Repair" and "Modify" are acceptable choices.

If prompted, do NOT reboot after an individual software is done
installing – this will not allow the rest of the software to be
installed and the process will have to be restarted.

Reboot the system only after all software is installed.
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5. 1 Run the QET Setup Wizard

1. Download the QET SetupWizard.

2. Double-click the QET SetupWizard icon.

3. Click Next to continue.
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4. Click I Agree to continue after reviewing all terms of the
End User License Agreement (EULA).

5. Click Next to continue or change the Destination Folder for file installation.
Default Location:
C:\Users\<CurrentUser>\Documents\Keysight Quantum Engineering Toolkit



5 Install Software

6. Click Next to continue.

7. Read and follow the remaining on-screen prompts to unzip all components.
A batch script executes and each component’s installer will start.

If any software is already installed, a prompt will ask if you
would like to "Modify", "Repair", or "Remove" the software;
"Repair" and "Modify" are acceptable choices.

If prompted, do NOT reboot after an individual software is done
installing – this will not allow the rest of the software to be
installed and the process will have to be restarted.

Reboot the system only after all software is installed.

8. Reboot the system after the batch script is completed.

A readme file is placed in:
C:\Users\<CurrentUser>\Documents\Keysight Quantum Engineering Toolkit

Firmware updates for M3xxxA modules must be performedmanually through
Keysight SD1. Check for recommended firmware versions in the readme file
and follow the instructions on the next page to update the firmware for all
modules that require it.
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5. 2 Update Firmware

1. Select Start > Keysight > Keysight SD1 SFP.

2. Select Help > Hardware Manager.

3. View the list under Module
a. In the Available FW Version column, for each module listed,

select the drop-downmenu arrow and select a FW Version.

b. In the Update column, for each module listed,
select the drop-downmenu arrow and select Yes.

4. Select Update Selected HW.

5. Follow the on-screen instructions to download and install all new firmware.

6. When prompted, shutdown the system – not doing so at the time of the prompt
will result in firmware versions not being updated.
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6 Verify Operation

The following list of hardware components are the recommended
models usedwith the Keysight QuantumEngineering Toolkit. The
hardware configurations are shown using the Keysight M9019A
PXIe Chassis; this chassis andmany other hardware components
may have optional or alternate models available. Refer to Review
Hardware Components on page 9.

Each of the following procedures has been written so that each
one can be performed independent of the others; if you are
performing all of these procedures in the order shown, youmay
notice that some of the steps are repeated.

Perform the following sequence when verifying operation:

1. Verify Operation of each AWG, Digitizer, and Chassis on page 34
a. Connect Cables

b. Configure each AWG and Digitizer

c. Verify Operation of AWGs and Digitizers, Frequency Spectrum

d. Verify Operation of AWGs and Digitizers, Time Domain

2. Verify Operation of each M9347AH01 PXIe Dual DDS (LO) on page 39
a. Connect Cables

b. Configure a Frequency Reference

c. Configure an M9347AHO1 PXIe Dual DDS Module

d. Verify Operation of each Dual DDS Module with a Spectrum Analyzer

3. Verify Operation of each U3022AH37 I/QModulator on page 43
a. Connect Cables

b. Configure a Frequency Reference

c. Configure each AWG

d. Configure an M9347AHO1 PXIe Dual DDS Module

e. Verify Operation of the I/QModulator with a Spectrum Analyzer

4. Verify Operation of each U3022AH37 I/Q Demodulator on page 48
a. Connect Cables, High-Pass Filter, and Attenuator

b. Configure a Frequency Reference

c. Configure each AWG and Digitizer

d. Configure an M9347AHO1 PXIe Dual DDS module

e. Verify Operation of the I/Q Demodulator, Frequency Spectrum

f. Verify Operation of the I/Q Demodulator, Time Domain



6 Verify Operation

6. 0. 1 Verify Operation of each AWG, Digitizer, and Chassis

6. 0. 1. 1 Connect Cables

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

1. Connect a Y1202A or Y1203A PCIe cable to
an M9049A or M9049B PCIe Host Adapter in the HP Z8 G4Workstation.

2. Use SMA (m) to SMA (m) cables for the following connections:

a. Connect AWGCh 1 Out to Digitizer Ch 1 In.

b. Connect AWGCh 2 Out to Digitizer Ch 2 In.

c. Connect AWGCh 3 Out to Digitizer Ch 3 In.

d. Connect AWGCh 4 Out to Digitizer Ch 4 In.

6. 0. 1. 2 Configure each AWG and Digitizer

1. Start the Soft Front Panel and configure each AWG and Digitizer
by selecting Start > Keysight > Keysight SD1 SFP.

2. Verify Operation Using the Frequency Spectrum

3. Verify Operation Using the Time Domain
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6. 0. 1. 3 Verify Operation of AWGs and Digitizers, Frequency Spectrum

1. Configure channels 1, 2, 3, and 4 of the AWG.

a. Select View > New Panel.

b. Select Channel drop-downmenu, 1, and OK to add Channel 1.

c. Repeat these steps to add Channels 2, 3, and 4.

d. On Channel 1 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 1.0 V

Frequency (MHz): 50 MHz

Phase: 0.00

DC offset: 0.000

e. On Channel 2 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 1.0 V

Frequency (MHz): 100 MHz

Phase: 0.00

DC offset: 0.000

f. On Channel 3 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 1.0 V

Frequency (MHz): 150 MHz

Phase: 0.00

DC offset: 0.000

g. On Channel 4 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 1.0 V

Frequency (MHz): 200 MHz

Phase: 0.00

DC offset: 0.000

h. On Channel 1, 2, 3, and 4, clear the HiZ check box
to enable the output of each channel.

i. Select Settings > Reset Accumulated Phase > Reset Phase.
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2. Configure channels 1, 2, 3, and 4 of the Digitizer.

a. Select the Frequency tab.

b. Select the check box for Channel 1, 2, 3, and 4.

c. Set Points to 1000.

d. Set Channel 1, 2, 3, and 4 to the following settings:

Impedance: 50 Ω

Full Scale: 1 V

Position: 0.000 V

Prescaler: 0

3. Verify Operation Using the Frequency Spectrum

Verify each channel is working correctly by looking at the Frequency tab of the
Digitizer; there should be a signal at 50, 100, 150, and 200 MHz.
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6. 0. 1. 4 Verify Operation of AWGs and Digitizers, Time Domain

1. Configure channels 1, 2, 3, and 4 of the AWG:

a. On Channel 1 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 1.0 V

Frequency (MHz): 1 MHz

Phase: 0.00

DC offset: 0.000

b. On Channel 2 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 1.0 V

Frequency (MHz): 2 MHz

Phase: 0.00

DC offset: 0.000

c. On Channel 3 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 1.0 V

Frequency (MHz): 3 MHz

Phase: 0.00

DC offset: 0.000

d. On Channel 4 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 1.0 V

Frequency (MHz): 4 MHz

Phase: 0.00

DC offset: 0.000

e. On Channel 1, 2, 3, and 4, clear the HiZ check box
to enable the output of each channel.

f. Select Settings > Reset Accumulated Phase > Reset Phase.

2. Configure channels 1, 2, 3, and 4 of the Digitizer to view the Time domain.

a. Select the Time tab.

b. Select the check box for Channel 1, 2, 3, and 4.

c. Set Points to 1000.

d. Set Channel 1, 2, 3, and 4 to the following settings:

Full Scale: 1 V

Position: 0.000 V

Prescaler: 0

Impedance: 50 Ω



6 Verify Operation

3. Verify each channel is working correctly by looking at the Time domain tab of
the Digitizer.

There should be four sine waves displayed, each with a different period that
corresponds to 1, 2, 3, and 4 MHz where:
f(Frequency) = 1/t (Period)

Frequency Approximate Period

1 MHz 1.00 µs

2 MHz 0.50 µs

3 MHz 0.33 µs

4 MHz 0.25 µs
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6. 0. 2 Verify Operation of each M9347AH01 PXIe Dual DDS (LO)

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.
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6. 0. 2. 1 Connect Cables

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

1. Connect a Y1202A or Y1203A PCIe cable to
an M9049A or M9049B PCIe Host Adapter in the HP Z8 G4Workstation.

2. Connect the E8267D PSG RF Output to the M9347AH01 Clock In.

a. Connect a 3.5 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 520
or connect a 2.4 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 532 or 544.

b. Connect one end of SMA (m) to SMA (m) cable to the 3.5 mm (f) adapter.

c. Connect the other end of the SMA cable to the M9347AH01 Clock In.

3. Connect the M9347AH01 Synth Out 1 to a spectrum analyzer input.

a. Connect a Type-N (m) to SMA (f) adapter on the spectrum analyzer input.

b. Connect one end of SMA (m) to SMA (m) cable to the SMA (f) adapter.

c. Connect the other end of the SMA cable to M9347AH01 Synth Out 1.

6. 0. 2. 2 Configure a Frequency Reference

If using the Keysight E8257D or E8267D PSG Signal Generator as the
frequency reference, perform the following:

a. Select [FREQUENCY] and enter 19.2 GHz.

b. Select [AMPLITUDE] and enter 0.00 dBm.

c. Select [RF On/Off] so that RF Output is On.

If a different frequency reference is being used, refer to the user documentation
for that product to learn how to set the frequency and power to the settings
listed above.
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6. 0. 2. 3 Configure an M9347AHO1 PXIe Dual DDSModule

1. Start the Soft Front Panel for each M9347AH01 PXIe Dual DDS module
by selecting Start > Keysight M9347 PCIe Module > M9347 SFP.

2. From the Connect to Instrument dialog, select a M9347AH01module.
(If there is more than one M9347AH01module in the system, use the physical
Chassis and Slot number, displayed in the dialog box, to determine which
M9347AH01 that is to be connected.)

3. Using the Keysight M9347A PXIe Module SFP, select the DDS Control tab, and
set the output settings for DDS 1 (Synth Out 1 connector):

a. Set Clock Source to 19.2 GHz Clock.
(This value shouldmatch the frequency being applied to Clock In.)

b. Set Ref Out to Disabled.

c. Select Run Clock Alignment. (This performs an internal alignment to lock
the DDS chips to the system Clock Source. This alignment must be
performed each time system Clock Source is changed.)

d. Set Frequency to 5 GHz.

e. Set Power Level to 0 dBm.

f. Set Phase to 0 degrees.

g. Select the check box, Output Enabled, to enable
the Synth Out 1 connector.
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6. 0. 2. 4 Verify Operation of each Dual DDS with a Spectrum Analyzer

1. Using a spectrum analyzer, verify the output of the Synth Out 1 connector:

a. Verify the Frequency is 5 GHz.

b. Verify the Power Level is approximately 0 dBm.

c. Verify there are no spikes near the signal.

d. (Optional) Adjust the power level and frequency on the SFP and verify the
power level and frequency change to the corresponding frequency and
power levels on the spectrum analyzer.

2. Move the connection from Synth Out 1 to Synth Out 2 and use the spectrum
analyzer to repeat the verification steps for the Synth Out 2 connector.

Settings for the Synth Out 2 connector are controlled with DDS 2 values.
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6. 0. 3 Verify Operation of each U3022AH37 I/Q Modulator

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.
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6. 0. 3. 1 Connect Cables

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

1. Connect a Y1202A or Y1203A PCIe cable to
an M9049A or M9049B PCIe Host Adapter in the HP Z8 G4Workstation.

2. Connect SMA (m) to SMA (m) cables from AWG to I/QModulator being verified:

a. Connect AWGCh 1 Out to I/QModulator I In.

b. Connect AWGCh 2 Out to I/QModulator Q In.

c. Connect AWGCh 3 Out to I/QModulator Pin Sw.

I/QModulator Pin Sw connector is an SMB (m).
If using an SMA (m) to SMA (m) cable to connect to
I/QModulator Pin Sw, use an SMA (f) to SMB (m) to
SMB (f) to SMB (f) or a single SMA (f) to SMB (f).

3. Connect the E8267D PSG RF Output to the M9347AH01 Clock In.

a. Connect a 3.5 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 520
or connect a 2.4 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 532 or 544.

b. Connect one end of SMA (m) to SMA (m) cable to the 3.5 mm (f) adapter.

c. Connect the other end of the SMA cable to the M9347AH01 Clock In.

4. Connect the M9347AH01 Synth Out 1 to I/QModulator LO In.

5. Connect the I/QModulator RF Out to the input of a spectrum analyzer.

a. Connect a Type-N (m) to SMA (f) adapter on the spectrum analyzer input.

b. Connect one end of an SMA (m) to SMA (m) cable to the SMA (f) adapter.

c. Connect the other end of the SMA cable to an I/QModulator RF Out.

6. 0. 3. 2 Configure a Frequency Reference

If using the Keysight E8257D or E8267D PSG Signal Generator as the
frequency reference, perform the following:

a. Select [FREQUENCY] and enter 19.2 GHz.

b. Select [AMPLITUDE] and enter 0.00 dBm.

c. Select [RF On/Off] so that RF Output is On.

If a different frequency reference is being used, refer to the user documentation
for that product to learn how to set the frequency and power to the settings
listed above.
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6. 0. 3. 3 Configure each AWG

1. Start the Soft Front Panel and Configure each AWG
by selecting Start > Keysight > Keysight SD1 SFP.

2. Configure channels 1, 2, and 3 of the AWG:

a. Select View > New Panel.

b. Select Channel drop-downmenu, 1, and OK to add Channel 1.

c. Repeat these steps to add Channels 2 and 3.

d. On Channel 1 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 0.1 V

Frequency (MHz): 100 MHz

Phase: 0.00 degrees
(This is the in-phase component of the I/Q signal being applied to
the I/QModulator.)

DC offset: 0.000 V

e. On Channel 2 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 0.1 V

Frequency (MHz): 100 MHz

Phase: 90.00 degrees
(This is the quadrature-phase component of the I/Q signal being
applied to the I/QModulator.)

DC offset: 0.000 V

f. On Channel 3 SFP, select:

Waveform shape: DC

Amplitude: 0 V

Frequency (MHz): 0

Phase: 0.00 degrees

DC offset: 0.5 V

When operating the I/Q Modulator Pin Switch, the control signal may leak into
the RF Out and damage an amplifier if it is connected directly to the output of the
RF Out connector. To help protect devices, it is recommended that a high-pass filter be
connected on the RF Out connector with a cutoff frequency of at least 2 GHz.
(For example, a Mini-Circuits 15542 High-Pass Filter with a frequency range of 2010 to
10100 MHz.)

The actual high-pass filter model depends on the frequency range of the
I/Q Modulator being used.

g. On Channel 1, 2, and 3, clear the HiZ check box to enable outputs.
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6. 0. 3. 4 Configure an M9347AHO1 PXIe Dual DDSModule

1. Start the Soft Front Panel for each M9347AH01 PXIe Dual DDS module by
selecting Start > Keysight M9347A PCIe Module > M9347 SFP.

2. From the Connect to Instrument dialog, select a M9347AH01module.
(If there is more than one M9347AH01module in the system, use the physical
Chassis and Slot number, displayed in the dialog box, to determine which
M9347AH01 that is to be connected.)

3. Using the Keysight M9347 PXIe Module SFP, select the DDS Control tab, and
set the output settings for DDS 1 (Synth Out 1 connector):

a. Set Clock Source to 19.2 GHz Clock.
(This shouldmatch the frequency being applied to Clock In.)

b. Set Ref Out to Disabled.

c. Select Run Clock Alignment. (This performs an internal alignment to lock
the DDS chips to the system Clock Source. This alignment must be
performedwhenever the system Clock Source is changed.)

d. Set Frequency to 5 GHz.

e. Set Power Level to 0 dBm.

f. Set Phase to 0 degrees.

g. Select the check box, Output Enabled, to enable
the Synth Out 1 connector.
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6. 0. 3. 5 Verify Operation of an I/Q Modulator with a Spectrum Analyzer

1. Verify there is an LO feed-through signal at 5 GHz as shown at Marker 1.

2. Verify there are mixing products that correspond to the frequencies set on the
AWGSoft Front Panel; in the above example, Frequency was set to 100 MHz
for Ch 1 and Ch 2, so there should be mixing product signals at 4.9 GHz and
5.1 GHz. (Marker 2 is used to label the 5.1 GHz signal. A signal is also shown at
4.9 GHz, but is not labeled with a Marker.)

3. Verify that when the signal level from AWGCh 3, which should be connected to
the I/QModulator Pin Sw, goes below 0.2 V, the pin switch in the I/QModulator
is turned off; the result looks like the I/QModulator is turned off, as shown
below.
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6. 0. 4 Verify Operation of each U3022AH37 I/Q Demodulator

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.
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6. 0. 4. 1 Connect Cables, High-Pass Filter, and Attenuator

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

1. Connect a Y1202A or Y1203A PCIe cable to
an M9049A or M9049B PCIe Host Adapter in the HP Z8 G4Workstation.

2. Connect SMA (m) to SMA (m) cables from an AWG to an I/QModulator:

a. Connect AWGCh 1 Out to I/QModulator I In.

b. Connect AWGCh 2 Out to I/QModulator Q In.

c. Connect AWGCh 3 Out to I/QModulator Pin Sw.

d. I/QModulator Pin Sw connector is an SMB (m).
If using an SMA (m) to SMA (m) cable to connect to
I/QModulator Pin Sw, use an SMA (f) to SMB (m) to
SMB (f) to SMB (f) or a single SMA (f) to SMB (f).

3. Connect SMA (m) to SMA (m) cables from an I/Q Demodulator to a Digitizer:

a. Connect the I/Q Demodulator I Out to Digitizer Ch 1 In.

b. Connect the I/Q Demodulator Q Out to Digitizer Ch 2 In.

4. Connect the E8267D PSG RF Output to the M9347AH01 Clock In:

a. Connect a 3.5 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 520
or connect a 2.4 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 532 or 544.

b. Connect one end of SMA (m) to SMA (m) cable to the 3.5 mm (f) adapter.

c. Connect the other end of the SMA cable to the M9347AH01 Clock In.

5. Connect SMA (m) to SMA (m) cables fromM9347AH01 to both
the I/QModulator and I/Q Demodulator:

a. Connect the M9347AH01 Synth Out 1 to I/QModulator LO In.

b. Connect the M9347AH01 Synth Out 2 to I/Q Demodulator LO In.

6. Connect the I/QModulator RF Out to the I/Q Demodulator RF In
through a high-pass filter and a 30 dB attenuator:

a. Connect a high-pass filter directly to the I/QModulator RF Out.

b. Connect a 30 dB attenuator directly into the I/Q Demodulator RF In.

c. Connect one end of an SMA (m) to SMA (m) cable
to the high-pass filter; this is the side with RF Out.

d. Connect the other end of the SMA cable to the 30 dB attenuator that is
going into the I/Q Demodulator RF In.
This 30 dB attenuator may be removed when running actual Qubit
measurements; it is used here to protect the I/Q Demodulator RF In.
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6. 0. 4. 2 Configure a Frequency Reference

If using the Keysight E8257D or E8267D PSG Signal Generator as the
frequency reference, perform the following:

a. Select [FREQUENCY] and enter 19.2 GHz.

b. Select [AMPLITUDE] and enter 0.00 dBm.

c. Select [RF On/Off] so that RF Output is On.

If a different frequency reference is being used, refer to the user documentation
for that product to learn how to set the frequency and power to the settings
listed above.

6. 0. 4. 3 Configure each AWG and Digitizer

1. Start the Soft Front Panel and configure each AWG and Digitizer by selecting
Start > Keysight > Keysight SD1 SFP.

2. Configure channels 1, 2, and 3 of the AWG:

a. Select View > New Panel.

b. Select Channel drop-downmenu, 1, and OK to add Channel 1.

c. Repeat these steps to add Channel 2.

d. On Channel 1 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 0.1 V

Frequency (MHz): 100 MHz

Phase: 0.00 degrees
(This is the in-phase component of the I/Q signal being applied to
the I/QModulator.)

DC offset: 0.000 V

e. On Channel 2 SFP, select:

Waveform shape: Sinusoidal

Amplitude: 0.1 V

Frequency (MHz): 100 MHz

Phase: 90.00 degrees
(This is the quadrature-phase component of the I/Q signal being
applied to the I/QModulator.)

DC offset: 0.000 V

f. On Channel 3 SFP, select:

Waveform shape: DC

Amplitude: 0.0 V

Frequency (MHz): 0
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Phase: 0.00 degrees

DC offset: 0.5 V

When operating the I/Q Modulator Pin Switch, the control signal may leak
into the RF Out and damage an amplifier if it is connected directly to the output of the
RF Out connector. To help protect devices, it is recommended that a high-pass filter be
connected on the RF Out connector with a cutoff frequency of at least 2 GHz.
(For example, a Mini-Circuits 15542 High-Pass Filter with a frequency range of 2010 to
10100 MHz.)

The actual high-pass filter model depends on the frequency range of the
I/Q Modulator being used.

g. On Channel 1, 2, and 3, clear the HiZ check box to enable outputs.

3. Configure Ch 1 and Ch 2 of the Digitizer to view the Frequency spectrum.

a. Select the Frequency tab.

b. Select the check box for Channel 1 and 2.

c. Set Points: 5000

d. Set each Channel to the following settings:

Impedance: 50 Ω

Full Scale: 1 V

Position: 0.000 V

Prescaler: 0
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6. 0. 4. 4 Configure each M9347AHO1 PXIe Dual DDSModule

1. Start the Soft Front Panel for each M9347AH01 PXIe Dual DDS module
by selecting Start > Keysight M9347 PCIe Module > M9347 SFP.

2. From the Connect to Instrument dialog, select a M9347AH01module.
(If there is more than one M9347AH01module in the system, use the physical
Chassis and Slot number, displayed in the dialog box, to determine which
M9347AH01 that is to be connected.)

3. Using the Keysight M9347A PXIe Module SFP, select the DDS Control tab, and
set the output settings for DDS 1 (Synth Out 1 connector)
and DDS 2 (Synth Out 2 connector):

a. Set Clock Source to 19.2 GHz Clock. (Shouldmatch Clock In frequency.)

b. Set Ref Out to Disabled.

c. Select Run Clock Alignment. (This performs an internal alignment to lock
the DDS chips to the system Clock Source. This alignment must be
performed each time system Clock Source is changed.)

d. Set Frequency to 5 GHz for DDS 1 and DDS 2.

e. Set Power Level to 0 dBm for DDS 1 and DDS 2.

f. Set Phase to 0 degrees for DDS 1 and DDS 2.

g. Select the check box, Output Enabled, for DDS 1 and DDS 2, to enable
both the Synth Out 1 connector and the Synth Out 2 connector.
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6. 0. 4. 5 Verify Operation of an I/Q Demodulator, Frequency Spectrum

1. Verify that there is a signal at 100 MHz and a harmonic at 200 MHz.
Since AWGCh 3 is driving the I/QModulator Pin Sw with a DC offset of 0.5 V,
the I/QModulator is On (as shown below). When the AWGCh 3 Pin Sw signal is
set below 0.3 V, it sets the output of the I/QModulator to Off (not shown).
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2. Verify the I/QModulator can be amplitude modulated by injecting a
square wave signal into the Pin Sw connector, effectively turning the signal at
the RF Out connector on and off. The settings on AWGCh 3 can be used to
control the rate that the I/QModulator is switched on and off.

For example, with AWGCh 3 Out connected to I/QModulator Pin Sw, using an
SMA (m) to SMA (m) cable with an SMA (f) to SMB (f) adapter,
use the AWGChannel 3 SFP and select:

a. Waveform shape: Square

b. Amplitude: 0.5 V

c. Frequency (MHz): 10 MHz

d. Phase: 0.00 degrees

e. DC offset: 0.5 V

When operating the I/Q Modulator Pin Switch, the control signal may
leak into the RF Out and damage an amplifier if it is connected directly to the
output of the RF Out connector. To help protect devices, it is recommended that
a high-pass filter be connected on the RF Out connector with a cutoff frequency
of at least 2 GHz. (For example, a Mini-Circuits 15542 High-Pass Filter with a
frequency range of 2010 to 10100 MHz.)

The actual high-pass filter model depends on the frequency range of
the I/Q Modulator being used.
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6. 0. 4. 6 Verify Operation of an I/Q Demodulator, Time Domain

Configure channels 1 and 2 of the Digitizer to view the Time domain.

a. Select the Time domain tab.

b. Select the check box for Channel 1 and 2.

c. Set Points: 500

d. Set each Channel to the following settings:

a. Full Scale: 1 V

b. Position: 0.000 V

c. Prescaler: 0

d. Impedance: 50 Ω

e. Verify the frequency setting on AWGCh 3 is controlling the rate that the
I/QModulator is switched on and off.

The following display shows how the I/QModulator can have a square
wave applied that is used to amplitude modulate the output; it is on for
50% of the 10 MHz duty cycle (0.05 µs) and off for 50%.
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7 Run the QET Initialization Utility
The QET Initialization Utility is an IQ calibration software that minimizes undesired
mixing products that can be introduced by the Keysight U3022AH37 I/Q
Modulator/Demodulator Test Set on page 13. The result is a more stable and reliable
system that can be used by researchers, when producing IQ waveforms, and can be
applied to a Qubit Under Test.

As an example of minimizing undesiredmixing products, local oscillator andmirror
image feed-through signals can be minimized to improve spectral purity.

Improve Spectral Purity with the QET Initialization Utility

After running the QET Initialization Utility, a "Corrected" file (that contains all of the
results that were corrected by pre-distorting a waveform prior to loading it into
AWG memory), along with manual corrections made to settings on the AWGSFP and
Local Oscillator SFP produces two corrected I and Q waveform files; these two files
can then be loaded into AWGmemory, queued, and played from the two AWG
channels (AWGCh 1 and AWGCh 2). The final corrected IQ waveform, with improved
spectral purity, can be applied to a Qubit Under Test.

Summary of the QET Initialization Utility Process Flow

1. Install Hardware on page 60

a. Connect Cables on page 61

b. Configure a Frequency Reference on page 61

2. Start the QET Initialization Utility
by selecting Start > Keysight > QET Initialization Utility.
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3. Select the Equipment Setup Tab on page 62

a. Select an AWG and a Waveform Type on page 62

i. (Optional) Enter an AWGAlias.

ii. Select an AWGmodel number.

iii. Enter a waveform type and an AWG offset frequency.

iv. Enter/confirm the AWG chassis and slot number.
(The Resource Address is auto-filled from the
Model Number, Chassis, and Slot Number.)

b. Select one of the following as the Local Oscillator:

Select the M9347AH01 Dual DDS as the Local Oscillator
 on page 63

i. (Optional) Enter a Local Oscillator Alias.

ii. Select a Local Oscillator model number.

iii. Enter a Resource Address for the Local Oscillator.
a. Assign a valid VISA Alias to an M9347A. (M9347A-1)

b. Start the SCPI Service.

c. Enter the specific Resource Address.
(TCPIP0::localhost::hislip1::INSTR)

iv. Enter all Advanced Options for channel and power.
(channel=1;level=0)

or Select the E8267D or N5182B as the Local Oscillator on page 65

i. (Optional) Enter a Local Oscillator Alias.

ii. Select a Local Oscillator model number.

iii. Enter a Resource Address for the Local Oscillator.

iv. Enter all Advanced Options for channel and power.
(level=0)

c. Select a Signal Analyzer on page 66

i. (Optional) Enter a Signal Analyzer Alias.

ii. Select a Signal Analyzer model number.

iii. Enter a Resource Address for the Signal Analyzer.

iv. Leave the Advanced Options entry box empty.

4. Select the TxMixer Initialization Tab on page 67

a. Set the Stimulus and Select an UncorrectedWaveform File on page 67

i. Set the Stimulus (Frequency of the LO).

ii. Set the Stimulus (Channel Amplitude of the AWG).

iii. Select an UncorrectedWaveform File.

iv. Select a name for the CorrectedWaveform File.
The name is auto-filled by the program and based
on the entry for the UncorrectedWaveform File.

v. Select Execution to start the initialization.

58 Keysight QET Startup Guide



7 Run the QET Initialization Utility

Keysight QET Startup Guide 59

b. Execution of the QET Initialization Utility on page 68

c. Review Results after Execution of the QET Initialization Utility on page 69
i. Results, Corrected Using the AWGSFP and LO SFP on page 69

ii. Results, Corrected by Pre-distorting the Waveform on page 70

5. Review and Play Corrected I and QWaveform Files on page 71

a. Review the UncorrectedWaveform File on page 71

b. Review the Uncorrected vs. CorrectedWaveform File on page 72

c. Play AWG and LO Corrections with CorrectedWaveform File on page 73
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7. 1 Install Hardware

The following list of hardware components are the recommended
models usedwith the Keysight QuantumEngineering Toolkit. The
hardware configurations are shown using the Keysight M9019A
PXIe Chassis; this chassis andmany other hardware components
may have optional or alternate models available. Refer to Review
Hardware Components on page 9.

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.
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7. 1. 1 Connect Cables

In all equipment setups throughout this document, all cables are
the same and shown in different colors for clarity only.
See Cables, SMA (m) to SMA (m) on page 15.

1. Connect a Y1202A or Y1203A PCIe cable
to an M9049A or M9049B PCIe Host Adapter in the HP Z8 G4Workstation.

2. Connect SMA (m) to SMA (m) cables from an AWG to the I/QModulator:

a. Connect AWGCh 1 Out to I/QModulator I In.

b. Connect AWGCh 2 Out to I/QModulator Q In.

3. Connect the E8267D PSG RF Output to the M9347AH01 Clock In.

a. Connect a 3.5 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 520
or connect a 2.4 mm (f) to 3.5 mm (f) adapter
on the E8267D PSG RF Output with Option 532 or 544.

b. Connect one end of SMA (m) to SMA (m) cable to the 3.5 mm (f) adapter.

c. Connect the other end of the SMA cable to the M9347AH01 Clock In.

4. Connect the M9347AH01 Synth Out 1 to I/QModulator LO In.

5. Connect the I/QModulator RF Out to the input of a spectrum analyzer.

a. Connect a Type-N (m) to SMA (f) adapter on the spectrum analyzer input.

b. Connect one end of an SMA (m) to SMA (m) cable to the SMA (f) adapter.

c. Connect a high-pass filter directly to the I/QModulator RF Out.

d. Connect the other end of the SMA cable to an I/QModulator RF Out.

7. 1. 2 Configure a Frequency Reference

If using the Keysight E8257D or E8267D PSG Signal Generator as the
frequency reference, perform the following:

a. Select [FREQUENCY] and enter 19.2 GHz.

b. Select [AMPLITUDE] and enter 0.00 dBm.

c. Select [RF On/Off] so that RF Output is On.

If a different frequency reference is being used, refer to the user documentation
for that product to learn how to set the frequency and power to the settings
listed above.
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7. 2 Select the Equipment Setup Tab

7. 2. 1 Select an AWG and a Waveform Type

1. (Optional) Enter an AWG Alias.

2. Select an AWG model number.

3. Enter a waveform type and an AWG offset frequency.

4. Enter/confirm the AWG chassis and slot number.

The Resource Address is auto-filled from the Model
Number, Chassis, and Slot Number.

Name: This entry box is optional, but can be used to assign an "Alias" (a user-friendly
name) to the AWG that is used in the system.
In this example, AWG 1 is specified as the AWG Alias.

Model Number: A drop-down menu is used to display AWG models (M3202A, M3201A, M8190A)
that can be used with this software. Select the arrow for the drop-down menu
and select an AWG model number.
In this example, the M3202A is selected.

Resource Address: This entry is auto-filled from the Model Number drop-down menu selection
combined with values from the Chassis and Slot Number entries.
In this example, M3202A,1,2 is displayed.

Advanced Options: Enter waveformtype=ssb;offset=100e6

In this example, a single-sideband waveform type (ssb) is designated and has an
offset from the local oscillator frequency of 100 MHz (offset=100e6).
This 100 MHz offset entry must equal the frequency of the AWGs being used.
The waveformtype can be either: ssb or gaussian.

Chassis: This entry box is used to enter/confirm the chassis number housing the AWG.
In this example, there is only one chassis being used, so 1 was entered.

Slot Number: This entry box is used to enter/confirm the slot number, of the chassis, housing
the AWG.
In this example, the AWG is located in slot number two, so 2 was entered.
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7. 2. 2 Select a Local Oscillator

Select one of the following as the Local Oscillator:

Select the M9347AH01 Dual DDS as the Local Oscillator  on page 63

Select the E8267D or N5182B as the Local Oscillator on page 65

7. 2. 2. 1 Select the M9347AH01 Dual DDS as the Local Oscillator

1. (Optional) Enter a Local Oscillator Alias.

2. Select a Local Oscillator model number.

3. Enter a Resource Address for the Local Oscillator.

a. Assign a valid VISA Alias to an M9347A.

b. Start the SCPI Service.

c. Enter the specific Resource Address.

4. Enter all Advanced Options for channel and power.
(channel=1;level=0).

Name: This entry box is optional, but can be used to assign an "Alias" (a user-friendly
name) to the Local Oscillator that is used in the system.
In this example, LO 1 is specified as the Local Oscillator Alias.

Model Number: A drop-down menu is used to display Local Oscillator models (E8267D, N5182B,
M9347A) that can be used with this software. Select the arrow for the drop-
down menu and select a Local Oscillator model number.
In this example, the M9347A is selected.

Resource Address: This entry box is used to enter the VISA address of the Local Oscillator is used in
the system.

If the M9347A is selected from the drop-down menu as the Local Oscillator, it
must first be connected using a SCPI Service. The SCPI Service assigns a hislip
socket to each module that has a valid VISA Alias defined.

To assign a valid VISA Alias to each M9347A

1. Start the Soft Front Panel for each M9347A PXIe Dual DDS module by
selecting Start > Keysight M9347A PCIe Module > M9347 SFP.
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2. From the Connect to Instrument dialog, select an M9347AH01 module.
(If there is more than one M9347AH01 module in the system, use the
physical Chassis and Slot number, displayed in the dialog box,
to determine which M9347AH01 is being connected.)

3. Using the Keysight M9347 PXIe Module SFP, select
File > Save Connection... and enter M9347A-1 in the Name entry box.

Each valid VISA Alias must be of the form: M9347A-X
where X is an integer number, starting at 1.

If only one M9347A is in the system, this would be M9347A-1.
If there are two or more M9347A modules in the system, each
valid VISA Alias would be M9347A-1, M9347A-2, and so on.

4. Close the M9347A SFP. (The SCPI Service cannot start with this open.)

To start the SCPI Service

1. From QET Initialization Utility, select Tools > M9347 Connection Helper.

2. Enter M9347A in the Alias Base Number.

3. Select the Up/Down arrows to change the Number of Channels needed.
(This corresponds to the number of VISA Alias addresses needed.)

4. Select Start SCPI Service...

Once the SCPI Service has started, connect to it using the host name
(localhost) and hislip socket number (hislip1) as follows:
TCPIP0::localhost::hislip1::INSTR

In this example, if the M9347A-1 is selected, it requires a connection string in
the form of: TCPIP0::localhost::hislipX::INSTR
where X=1, so: TCPIP0::localhost::hislip1::INSTR is the specific
Resource Address.

If selecting M9347A-2, X=2, TCPIP0::localhost::hislip2::INSTR
would be the specific Resource Address. Close the M9347A SFP.
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Advanced Options: This entry box is used to enter the channel number (1 or 2 for the M9347A) and
power level of the Local Oscillator used in the system.

In this example, channel=1 of the M9347A refers to Synth 1 Out and level=0
refers to the Power Level, in dBm, of the Synth 1 Out. (Enter channel=1;level=0.)
To designate the Synth 2 Out of the M9347A, enter channel=2.

7. 2. 2. 2 Select the E8267D or N5182B as the Local Oscillator

1. (Optional) Enter a Local Oscillator Alias.

2. Select a Local Oscillator model number.

3. Enter a Resource Address for the Local Oscillator.

4. Enter all Advanced Options for channel and power.
(level=0)

Name: This entry box is optional, but can be used to assign an "Alias" (a user-friendly
name) to the Local Oscillator used in the system.

In this example, LO 1 is specified as the Local Oscillator Alias.

Model Number: A drop-down menu is used to display Local Oscillator models (E8267D, N5182B,
M9347A) that can be used with this software. Select the arrow for the drop-
down menu and select a Local Oscillator model number.
In this example, the N8267D is selected.

Resource Address: This entry box is used to enter the Resource Address (IP Address) of the
Local Oscillator used in the system.

In this example, since we are selecting to use an E8267D, it is addressed as:
TCPIP0::141.121.94.125::inst0::INSTR
The IP address of the E8267D, represented here as xxx.xxx.xxx.xxx was
replaced with the actual IP address of the E8267D.

To determine the IP address of the Keysight E8267D

Select [Utility] > I/O Config > LAN Setup > and read the IP address
displayed in the form= xxx.xxx.xxx.xxx

Advanced Options: This entry box is used to enter the power level of the Local Oscillator used in the
system.

In this example, level=0 refers to the Power Level, in dBm, of the RF Output.
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7. 2. 3 Select a Signal Analyzer

1. (Optional) Enter a Signal Analyzer Alias.

2. Select a Signal Analyzer model number.

3. Enter a Resource Address for the Signal Analyzer.

4. Leave the Advanced Options entry box empty.

There are currently no Advanced Options needed.

Name: This entry box is optional, but can be used to assign an "Alias" (a user-friendly
name) to the Signal Analyzer used in the system.

In this example, SA 1 is specified as the Alias.

Model Number: A drop-down menu is used to display Signal Analyzer models (N9010A, N9020A,
N9030A, N9040A, N9040B) that can be used with this software. Select the arrow
for the drop-down menu and select a Signal Analyzer model number.
In this example, the N9040B is selected.

Resource Address: This entry box is used to enter the Resource Address (IP Address) of the
Signal Analyzer used in the system.

In this example, since we are selecting to use an N9040B, it is addressed as:
TCPIP0::141.121.92.52::inst0::INSTR

The IP address of the N9040B, represented here as xxx.xxx.xxx.xxx was
replaced with the actual IP address of the N9040B.

To determine the IP address of the Keysight N9040B UXA Signal Analyzer

Select the Settings Icon

Select System > Show System > and read the IP address being
displayed in the form= xxx.xxx.xxx.xxx

Advanced Options: Leave the Advanced Options entry box empty.

There are currently no Advanced Options needed for the Signal Analyzer.
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7. 3 Select the Tx Mixer Initialization Tab

7. 3. 1 Set the Stimulus and Select an UncorrectedWaveform File

1. Set the Stimulus (Frequency of the LO).

2. Set the Stimulus (Channel Amplitude of the AWG).

3. Select an Uncorrected Waveform File.

4. Select a name for the Corrected Waveform File.
The name is auto-filled by the program and based on
the entry for the Uncorrected Waveform File.

5. Select Execution to start the initialization.

Frequency This entry box is used to enter the Stimulus frequency of the Local Oscillator.
Refer to Select a Local Oscillator on page 63.
In this example, 5 GHz is specified as the frequency of the Local Oscillator.

Channel Amplitude This entry box is used to enter the Stimulus AWG Channel Amplitude.
In this example, 100 mV is specified as the Channel Amplitude and corresponds
to AWG Ch 1 Out and AWG Ch 2 Out; both AWG outputs must be the same.

Waveform File
   Uncorrected

This selection box is used to select the Uncorrected Waveform File used when
running the QET Initialization Utility.

To select an Uncorrected Waveform File

1. Select the folder icon and navigate to the Waveforms folder:
C:\Program Files\Keysight\Quantum Engineering
Toolkit\Waveforms

2. Select an the Uncorrected Waveform File; this file is used during the
QET Initialization Utility.

In this example, SSB_100MHz.csv was selected. Note that each row contains
two values separated by a comma. In line one, the first entry starts with a value
of 1 and the second entry starts with a value of 0. The first entry (which is used
to play on AWG Ch 1), is the Cosine waveform and the second entry (which is
used to play on AWG Ch 2) is the Sine waveform.

Waveform File
   Corrected

This entry box is used to select a name for the Corrected Waveform File.

The name for the Corrected Waveform File is auto-filled by the program; the
name is based on the filename used in the Uncorrected Waveform File entry.
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To select a name for the Corrected Waveform File

1. Select the folder icon and navigate to the Documents folder:
\This PC\Documents

2. Select the name filled by the program or change it to a custom name.

In this example, the name that is auto-filled by the program is:
SSB_100MHz_Corrected.csv.

The Corrected Waveform File adds the Correction Results for:
I-Offset (Fine), Q-Offset (Fine), Quadrature Skew,
and Timing Skew.

The Correction Results for I-Offset (Coarse), Q-Offset (Coarse),
and Gain Imbalance must still be corrected using the Keysight
SD1 SFP for AWG Ch 1 and AWG Ch 2.

The Correction Result for LO Power Level must still be
corrected using the selected LO.

If the M9347AH01 was used, the M9347 SFP can be
used to change the DDS Power Level.

If the E8267D or N5182B was used, adjust the
Power Level using their specific front panel
[AMPLITUDE] control.

7. 3. 2 Execution of the QET Initialization Utility

Execution Button The Execution button (green) is used to start the QET Initialization Utility.

Stop Button The Stop button (red) is used to stop execution of the QET Initialization Utility.
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7. 3. 3 Review Results after Execution of the QET Initialization Utility

Three of these Results can be corrected using the AWGSFP and
one can be corrected using the Local Oscillator SFP.

The I-Offset (Coarse), Q-Offset (Coarse), and
Gain Imbalance can be corrected using the AWGSFP.

The LO Power Level can be corrected using the
Local Oscillator SFP.

Programming commands can also be used in place of the
SFP controls. See the AWGUser's Guide (M3201-90001).

The remaining correction Results are made by pre-distorting the
uncorrectedwaveform prior to loading it into AWG memory.

7. 3. 3. 1 Results, Corrected Using the AWG SFP and LO SFP

The following results can be corrected using the AWGSFP and LO SFP; they are not
currently being corrected by pre-distorting the waveform prior to loading it into
AWG memory.

I-Offset (Coarse) This correction value is the amount of DC offset needed from
AWG Ch 1 Out. This correction can be made using the SD1 SFP for AWG Ch 1.

Q-Offset (Coarse) This correction value is the amount of DC offset needed from
AWG Ch 2 Out. This correction can be made using the SD1 SFP for AWG Ch 2.

Gain Imbalance This correction value is the Gain-Imbalance of the Q-Channel relative
to the I-Channel and is applied by adding a correction value to the Q-Channel
amplitude. This correction can be made using the SD1 SFP for AWG Ch 2.

LO Power Level This correction value is the LO Power Level applied during the calibration.

The correction must be made using the selected local oscillator.

If the M9347AH01 was used as the local oscillator, the M9347 SFP can
be used to change the DDS Power Level.

If the E8267D or N5182B was used as the local oscillator, adjust the
LO Power Level using their specific front panel [AMPLITUDE] control.

https://literature.cdn.keysight.com/litweb/pdf/M3201-90001.pdf
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7. 3. 3. 2 Results, Corrected by Pre-distorting the Waveform

The following results cannot be corrected using the AWGSFP and LO SFP; these
results are corrected by pre-distorting the waveform prior to loading it into
AWG memory.

I-Offset (Fine) This correction value is a finer adjustment than the I-Offset (Coarse) correction
value of DC offset needed from AWG Ch 1 Out. Since the resolution needed to
make this adjustment cannot be accomplished using SD1 SFP for AWG Ch 1 or
the channelOffset command, the correction is instead applied by predistorting
the target waveform prior to loading it into memory. This correction value is
represented as a percentage of the full scale DAC value.

Q-Offset (Fine) See the explanation for the I-Offset (Fine) correction value. Q-Offset (Fine) also
does not have the resolution needed.

Quadrature Skew This correction value is the Quadrature Skew-Imbalance of the Q-Channel
relative to the I-Channel and is applied by adding a correction value
to the Q-Channel Phase.

In this example, AWG Ch 1 is applying a Cosine wave (In-Phase) and AWG Ch 2
is applying a Sine wave (90 degrees out of phase with AWG Ch 1; this is also
referred to as Quadrature.) The Quadrature Skew is the amount of correction
needed for AWG Ch 2 so that it is 90 degrees out of phase with AWG Ch 1.

Timing Skew This correction needs to be applied to AWG Ch 2 so that its waveform starts at
precisely the same time that the waveform from AWG Ch 1 starts.

For example, if the output of Ch 2 must be delayed and since an M3202A is
being used as the AWG, each waveform step is 1 ns. By placing a 0 in the first
entry, the start of the waveform for Ch 2 is delayed by 1 ns. This effectively
makes a correction of -1E-09 s so that the Sine wave from AWG Ch 2 is
delayed and starts after the Cosine wave from AWG Ch 1.

This correction value is applied to AWG Ch 2 by pre-distorting the waveform
prior to loading it into memory.
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7. 3. 4 Review and Play Corrected I and QWaveform Files

7. 3. 4. 1 Review the Uncorrected Waveform File

Continuing with the example, SSB_100MHz.csvwas the UncorrectedWaveform File.
Use a text editor (such as Notepad) to open this file and see that each row contains
two values separated by a comma. In line one, the first entry starts with a value of 1
and the second entry starts with a value of 0. The first entry of each line (which is later
used to play on AWGCh 1), is the Cosine waveform and the second entry of each line
(which is later used to play on AWGCh 2) is the Sine waveform.

Plotting these points show that they approximately represent a Cosine waveform and
a Sine waveform that are 90 degrees out of phase. (Cosine waveform points are
shown in blue and Sine waveform points are shown in red.)

After Execution (running the QET Initialization Utility), the contents of
SSB_100MHz.csv (Uncorrected) vs. SSB_100MHz_Corrected.csv (Corrected)
can be viewed and compared.
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7. 3. 4. 2 Review the Uncorrected vs. Corrected Waveform File

The Corrected file adds the Correction Results for:
I-Offset (Fine), Q-Offset (Fine), Quadrature Skew, and Timing Skew.

The Correction Results for I-Offset (Coarse), Q-Offset (Coarse), and
Gain Imbalance must still be corrected using the Keysight SD1 SFP
for AWGCh 1 and AWGCh 2.

The Correction Result for LO Power Level must still be corrected using the
selected LO. If the M9347AH01 was used, the M9347 SFP can be used to
change the DDS Power Level. If the E8267D or N5182B was used, adjust the
Power Level using their specific front panel [AMPLITUDE] control.
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7. 3. 4. 3 Play AWG and LO Corrections with Corrected Waveform File

The following process starts with a "Corrected" file. (This file contains all of the
Results that were corrected by pre-distorting the waveform prior to loading it into
AWG memory.) The "Corrected" file is split into two files (so that it can be played on
AWGCh 1 and AWGCh 2). Corrections are then applied to each channel using the
AWGSFP. If the LO Power Level must be corrected, the LO SFP or the specific front
panel [AMPLITUDE] control of the LO is adjusted so that the AWGwaveforms, from
AWGCh 1 and AWGCh 2, contain all of the corrections.

1. Using any .csv editor (such as Excel), open the SSB_100MHz_Corrected.csv file
and create two additional files that are going to be played using
SD1 SFP for AWGCh 1 and AWGCh 2.
(This splits the "Corrected" file into two files.)

Name the new files:

SSB_100MHz_Corrected_I.csv

SSB_100MHz_Corrected_Q.csv
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2. Using a text editor (such as Notepad), add text to the header and save these
new .csv files as follows:

waveformName,Corrected_I

waveformPoints,40

waveformType,WAVE_ANALOG_16

and

waveformName,Corrected_Q

waveformPoints,40

waveformType,WAVE_ANALOG_16

The entry waveformPoints,40was used in this example
because there are 40 sample points in the file. If the number of
samples is different in the file being used, this number would
be different; for example, if there are 100 sample points in the
file, this line should be: waveformPoints,100.

3. Save the edits so that the files look like the following:

4. Open SD1 SFP > Settings > AWGMemory.

5. On the AWGOnboard waveformmemory dialog box, select the small red x
next to any waveforms that may have been listed from previous examples.

6. On this AWGOnboard waveformmemory dialog box, select the small green +
on the left to open a window and navigate to the folder that the newly edited
I and Q waveform files are saved in and select Ok.
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7. With SD1 SFP open, select Settings > AWGQueue> AWG 2.

8. Select Trigger Mode Auto and change the drop-downmenu to SW/HVI START
and select Ok.

Whenmaking the changes through the AWGSFP, to enter
values in millivolts, select the tool icon.

The tool iconmust be selected to allow the entries to be
changed to the millivolts scale; the AWG SFP will not have
the needed resolution if the millivolts scale is not selected.

9. Using the SD1 SFP for Channel 1, adjust the DC offset by the amount shown in
the I-Offset (Coarse) result (in this example, the value is -16.92 mV).

10. Using the SD1 SFP for Channel 2, adjust the DC offset by the amount shown in
the Q-Offset (Coarse) result (in this example, the value is -10.8 mV).

11. Using the SD1 SFP for Channel 2, adjust the Amplitude by the amount shown in
the Gain Imbalance result (in this example, the value is 6.3 mV). Since the
Amplitude level was already 100 mV, it will have to be changed to 106.3 mV
(100 mV + 6.3 mV).

The corrected I and Q waveform files are loaded into AWGmemory, queued, and
played from the two AWG channels. The final result is a corrected IQ waveform being
played from AWGCh 1 and AWGCh 2; this final resultant IQ waveform has been
corrected and can be applied to a Qubit Under Test.
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8 Error Codes

8. 1 Error Codes for SD1 Programming Libraries

SD1 Error
Error
No

Refer to keysightSD1.py for Definition.

SD_Error.OPENING_MODULE -8000 Opening module

SD_Error.CLOSING_MODULE -8001 Closing module

SD_Error.OPENING_HVI -8002 Opening HVI

SD_Error.CLOSING_HVI -8003 Closing HVI

SD_Error.MODULE_NOT_OPENED -8004 Module not opened

SD_Error.MODULE_NOT_OPENED_BY_USER -8005 Module not opened by user

SD_Error.MODULE_ALREADY_OPENED -8006 Module already opened

SD_Error.HVI_NOT_OPENED -8007 HVI not opened, see SD1 commands:
assignHardwareWithIndexAndSerialNumber()
assignHardwareWithIndexAndSlot()
assignHardwareWithUserNameAndSerialNumber()
assignHardwareWithUserNameAndSlot()
assignHardwareWithUserNameAndModuleID()
compile()
compilationErrorMessage()
getNumberOfModules()
getModuleIndex()
getModuleByIndex()
getModuleByName()
load()
pause()
readIntegerConstantWithIndex()
readIntegerConstantWithUserName()
readDoubleConstantWithIndex()
readDoubleConstantWithUserName()
reset()
resume()
start()
stop()
writeIntegerConstantWithIndex()
writeIntegerConstantWithUserName()
writeDoubleConstantWithIndex()
writeDoubleConstantWithUserName()

SD_Error.INVALID_OBJECTID -8008 Invalid objectID

SD_Error.INVALID_MODULEID -8009 Invalid moduleID, see getType().
SD_Error.INVALID_MODULEUSERNAME -8010 Invalid moduleUsername

SD_Error.INVALID_HVIID -8011 Invalid HVIID

SD_Error.INVALID_OBJECT -8012 Invalid object

SD_Error.INVALID_NCHANNEL -8013 Invalid channelNumber

SD_Error.BUS_DOES_NOT_EXIST -8014 Bus does not exist

SD_Error.BITMAP_ASSIGNED_DOES_NOT_
EXIST

-8015 Any input assigned to the bitMap does not exist
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SD1 Error
Error
No

Refer to keysightSD1.py for Definition.

SD_Error.BUS_INVALID_SIZE -8016 Input size does not fit on this bus

SD_Error.BUS_INVALID_DATA -8017 Input data does not fit on this bus

SD_Error.INVALID_VALUE -8018 Invalid value, see newFromArrayDouble().
SD_Error.CREATING_WAVE -8019 Creating waveform

SD_Error.NOT_VALID_PARAMETERS -8020 Invalid parameters

SD_Error.AWG -8021 AWG failed

SD_Error.DAQ_INVALID_FUNCTIONALITY -8022 DAQ invalid functionality

SD_Error.DAQ_POOL_ALREADY_RUNNING -8023 DAQ buffer pool is already running

SD_Error.UNKNOWN -8024 Unknown error

SD_Error.INVALID_PARAMETERS -8025 Invalid parameters, see FFT().
SD_Error.MODULE_NOT_FOUND -8026 Module not found

SD_Error.DRIVER_RESOURCE_BUSY -8027 Driver resource busy

SD_Error.DRIVER_RESOURCE_NOT_READY -8028 Driver resource not ready

SD_Error.DRIVER_ALLOCATE_BUFFER -8029 Driver cannot allocate buffer

SD_Error.ALLOCATE_BUFFER -8030 Cannot allocate buffer

SD_Error.RESOURCE_NOT_READY -8031 Resource not ready

SD_Error.HARDWARE -8032 Hardware error

SD_Error.INVALID_OPERATION -8033 Invalid operation

SD_Error.NO_COMPILED_CODE -8034 No compiled code in the module

SD_Error.FW_VERIFICATION -8035 Firmware verification failed

SD_Error.COMPATIBILITY -8036 Compatibility error

SD_Error.INVALID_TYPE -8037 Invalid type

SD_Error.DEMO_MODULE -8038 Demo module

SD_Error.INVALID_BUFFER -8039 Invalid buffer

SD_Error.INVALID_INDEX -8040 Invalid index

SD_Error.INVALID_NHISTOGRAM -8041 Invalid histogram number

SD_Error.INVALID_NBINS -8042 Invalid number of bins

SD_Error.INVALID_MASK -8043 Invalid mask

SD_Error.INVALID_WAVEFORM -8044 Invalid waveform

SD_Error.INVALID_STROBE -8045 Invalid strobe

SD_Error.INVALID_STROBE_VALUE -8046 Invalid strobe value

SD_Error.INVALID_DEBOUNCING -8047 Invalid debouncing

SD_Error.INVALID_PRESCALER -8048 Invalid prescaler

SD_Error.INVALID_PORT -8049 Invalid port

SD_Error.INVALID_DIRECTION -8050 Invalid direction

SD_Error.INVALID_MODE -8051 Invalid mode

SD_Error.INVALID_FREQUENCY -8052 Invalid frequency

SD_Error.INVALID_IMPEDANCE -8053 Invalid impedance

SD_Error.INVALID_GAIN -8054 Invalid gain

SD_Error.INVALID_FULLSCALE -8055 Invalid full scale

SD_Error.INVALID_FILE -8056 Invalid file

SD_Error.INVALID_SLOT -8057 Invalid slot
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SD1 Error
Error
No

Refer to keysightSD1.py for Definition.

SD_Error.INVALID_NAME -8058 Invalid name

SD_Error.INVALID_SERIAL -8059 Invalid serial number

SD_Error.INVALID_START -8060 Invalid start

SD_Error.INVALID_END -8061 Invalid end

SD_Error.INVALID_CYCLES -8062 Invalid cycles

SD_Error.HVI_INVALID_NUMBER_
MODULES

-8063 Invalid number of modules on HVI

SD_Error.DAQ_P2P_ALREADY_RUNNING -8064 DAQ P2P is already running

SD_Error.OPEN_DRAIN_NOT_SUPPORTED -8065 Open drain not supported

SD_Error.CHASSIS_PORTS_NOT_
SUPPORTED

-8066 Chassis port not supported

SD_Error.CHASSIS_SETUP_NOT_
SUPPORTED

-8067 Chassis setup not supported

SD_Error.OPEN_DRAIN_FAILED -8068 Open drain failed

SD_Error.CHASSIS_SETUP_FAILED -8069 Chassis setup failed

SD_Error.INVALID_PART -8070 Invalid part

SD_Error.INVALID_SIZE -8071 Invalid size

SD_Error.INVALID_HANDLE -8072 Invalid handle



80 Keysight QET Startup Guide



9 References

Keysight QET Startup Guide 81

9 References
Keysight PXIe Chassis Family, Startup Guide (M9019-90001)

Keysight M9019A PXIe Chassis: 18-slot, 3U, 24 GB/s, Gen 3

Keysight M9018B PXIe Chassis: 18-slot, 3U, 8 GB/s, Gen 2

Keysight M9010A PXIe Chassis: 10-slot, 3U, 24 GB/s, Gen 3

Keysight M3202A PXIe Arbitrary WaveformGenerator, User's Guide (M3201-90001)

Keysight M3202A PXIe Arbitrary WaveformGenerator:
1 GSa/s, 14 bit, 400 MHz

Keysight M3201A PXIe Arbitrary WaveformGenerator:
500 MSa/s, 16 bit, 200 MHz

Keysight M3102A PXIe Digitizer: 500 MSa/s, 14 bit, 200 MHz

Keysight M3100A PXIe Digitizer: 100 MSa/s, 14 bit, 100 MHz

Keysight M3300A PXIe AWG and Digitizer Combination,
500 MSa/s, 16 bit and 100 MSa/s, 14 bit

Keysight M3302A PXIe AWG and Digitizer Combination
500 MSa/s, 16 bit, and 500 MSa/s, 14 bit

Keysight M9347AH01 PXIe Dual Direct Digital Synthesizer: 9 kHz to 12 GHz

Keysight M9347AH01 PXIe Dual Direct Digital Synthesizer,
Getting Started Guide (M9347-90001)

Keysight M9300A PXIe Frequency Reference: 10 MHz and 100 MHz

Keysight Y1212A Qty 1 Slot blocker kit: 5 slots

Keysight Y1213A Qty 1 PXI EMC filler panel kit: 5 slots

Keysight U3022AH37 I/QModulator/Demodulator Test Set

Keysight U3022AH37 I/QModulator/Demodulator Test Set,
User's and Service Guide (U3022-90011)

Keysight 8493A-30 Coaxial Fixed Attenuator: DC to 12.4 GHz, 30 dB

Keysight 8493B-30 Coaxial Fixed Attenuator: DC to 18 GHz, 30 dB

Keysight E8267D PSG Vector Signal Generator: 250 kHz to 20 GHz

Keysight E8257D PSG Analog Signal Generator: 250 kHz to 20 GHz

PULSARMICROWAVE CORPORATION, PS8-53-454/4S, 8-Way Power Divider

Keysight Instrument Rack Cabinet, User Manual (5967-9318)

Keysight E3662B Rack Cabinet, 2.0 m

Keysight E3661B Rack Cabinet, 1.6 m

Keysight E3663AC System Rail Kit (E3663-90001)

https://www.keysight.com/upload/cmc_upload/All/PXIeChassis_StartupGuide-Sept2018.pdf
http://www.keysight.com/find/m9019a
http://www.keysight.com/find/m9018b
http://www.keysight.com/find/m9010a
https://literature.cdn.keysight.com/litweb/pdf/M3201-90001.pdf
http://www.keysight.com/find/m3202a
http://www.keysight.com/find/m3201a
http://www.keysight.com/find/m3102a
http://www.keysight.com/find/m3100a
http://www.keysight.com/find/m3300a
http://www.keysight.com/find/m3302a
http://www.keysight.com/find/m9300a
http://www.keysight.com/find/y1212a
http://www.keysight.com/find/y1213a
http://www.keysight.com/find/e8267d
http://www.keysight.com/find/e8257d
https://www.pulsarmicrowave.com/spec_sheets/PS8-53-454-4S.pdf
https://literature.cdn.keysight.com/litweb/pdf/5967-9318.pdf
http://www.keysight.com/find/racks
http://www.keysight.com/find/racks
https://www.keysight.com/upload/cmc_upload/All/e3663-90001_Rebranded.pdf
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Software

Keysight Quantum Engineering Toolkit SetupWizard includes:

Microsoft .NET Framework

Keysight IO Libraries Suite

Keysight M902x PXIe SystemModule

Keysight PXIe Chassis Family

Keysight M9347 PXI LO Drivers

Keysight SD1 SFP [Soft Front Panels] Software

Keysight SD1 Programming Libraries

Keysight M3601A Hard Virtual Instrument (HVI) Design Environment Software

Keysight M3602A FPGA Design Environment Software

Keysight QET Initialization Utility

Tested PCs and External Controllers

Tested PC and PXI/AXIe Chassis Configurations (5990-7632EN)

HP Z8 G4Workstation (RecommendedModel) - See HP website.

Keysight M9049A PCIe Performance Host Adapter: Dual Port (x16), Gen 3

Keysight M9048B PCIe Host Adapter: Single Port, x8, Gen 3

Keysight M9023A PXIe Performance SystemModule: Dual Port (x16), Gen 3

Keysight M9022A PXIe SystemModule: Single Port, x8, Gen 3

Keysight Y1202A PCIe Cable: x8, 2.0 m

Keysight Y1203A PCIe Cable: x8, 0.5 m

Keysight M9037A PXIe Performance Embedded Controller: 4-slot, 3U, Gen 3

Keysight M9036A PXIe Embedded Controller: 3-slot, 3U, Gen 2

(Optional) Test Equipment

Keysight N9040B UXA Signal Analyzer (Frequency option depends on U3022AH37.)

Keysight DSA90254A InfiniiumHigh Performance Oscilloscope: 2.5 GHz
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http://www.keysight.com/find/iolibraries
http://www.keysight.com/find/m9023a
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